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1.1

Formatting

1.1.1 Guidelines for formatting your RICR document
A.

The standard font to use for Rule documents is Arial size 12.

B.

Use only the RICR-specific styles. After installing the RICR Template, which can
be downloaded from the Rules and Regulations homepage, you may see
additional styles in the drop-down list of styles which Word has automatically
generated. Those additional styles do not affect the documents you create;
however, you may use only the RICR-specific styles.
1.

Do not use the Design ribbon in Word to apply styles to your document.
Use the styles available in the Home ribbon.

2.

For examples of what the text looks like when the various styles are
applied, see Appendix 1: Examples of Styles in the RICR Template.

C.

When you copy and paste text from an existing document into the RICR
template, you can avoid introducing additional styles by selecting “Paste Special”
from the “Edit” menu, and then select “Unformatted Text;” however, this option
will also remove bold, italics and underlines.

D.

It is not permitted for a user to apply bold in the document for any reason. You
may apply underlines only when showing track changes. Italics may only be
used for Latin/legal terms.
1.

Certain RICR styles will apply bold to text as part of the style but it may
not be applied manually outside of the RICR styles.

2.

Bold, italics, and underline may not be used for emphasis.

E.

It may be necessary to click on a selected RICR style twice to apply the changes
when cutting and pasting into the template to remove any remaining formatting
such as underlines, bold, etc.

F.

Each paragraph in a Rule should have its own appropriate number/letter
for citation purposes.
1.

G.

The only exception is for definitions, which do not require
individual numbers or letters (see § 1.1.6 Definitions).

You can review all paragraph designations in your Rule by clicking “View” at the
top of the document, then clicking “Outline.” Using this feature to review your
Rule helps avoid skipping over numbers or letters when assigning paragraph
designations.
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H.

Whenever possible, convert images containing only text to a table in Word to
make that information searchable.

I.

If you are inserting an image into your Rule, be sure to add “Alt Text” to
describe the image and where someone may find more information about the
image. For instructions on how to add alt text, see § 1.1.5(D).
1.

J.

All tables should use the RICR Text style.

A table of contents (TOC) may be included in submitted Rules longer than
thirty (30) pages. To add a TOC:
1.

Begin your document with the RICR caption, then add the TOC.

2.

A page break should follow the TOC.

3.

The first heading of the Rule will begin at the top of the next page.

K.

You may not use any headers or footnotes in your Rule. No footnotes should
appear in your Rules.

L.

You may use page numbers in your Proposed Rule document, but these page
numbers must be removed before submitting your Final Rule.
1.

If you choose to use page numbers, they must be in the footer of your
rule and oriented to the bottom right corner of the document.

M.

Citations should be handled in the body of the document and should be
formatted in accordance with § 1.1.7 Citations.

N.

Contact the Administrative Records Office staff if you need help creating
documents or with the Rhode Island Code of Regulations Filing Application.

1.1.2 Do’s and Don’ts
A.

Final Rules files must be saved as a Word (.doc or .docx) file.

B.

Be sure to apply RICR styles to all text.

C.

Use track changes or strike-out and underline to indicate amended text in
Proposed Rules and redline documents.
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1.

Proposed adoptions should contain all text underlined.

2.

Proposed repeals should contain all struck-out text.

D.

Be sure to turn off all automatic numbering and bullets and number Rules
manually.

E.

Insert a tab between the paragraph designation and the text of the heading or
paragraph for proper alignment.
1.

All paragraph designations should be followed by a period (unless the
assigned level has parenthesis around the designation, in which case,
a period is not used) and a single tab and must follow the correct
hierarchy assigned in the RICR style.

F.

The RICR styles will automatically indent paragraphs to the appropriate place on
the page.

G.

Do not use the space bar, tab key, or ruler to align paragraphs to the left or
right. You must only press the Tab key once for each paragraph as described
above.

H.

Do not insert an additional hard return after a heading or a paragraph as the
template automatically inserts a line space when you start a new heading or
paragraph.

I.

Do not use enumerations within paragraphs.
1.

Example of original text: The Dept. of State requires that all Rules filers
(1) read the regulatory manual; (2) comply with the requirements found
therein; and (3) contact Administrative Records with any questions.

2.

Instead, format this paragraph as follows:
a.

J.

The Dept. of State requires that all Rules filers:
(1)

Read the Regulatory manual;

(2)

Comply with the requirements found therein; and

(3)

Contact Administrative Records with any questions.

You may insert hyperlinks within your Rule. These links will work and display in
the application. You can link to other parts in the Code, areas of the Code of
Federal Regulations, United States Code, forms or Guidance Documents
published on your website, or incorporated materials, as appropriate.
1.

Before submitting your Rule, ensure that all hyperlinks inserted are active
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and send the user to the intended webpage.
2.

K.

If you are linking to other parts in the RICR, be sure to link to the part’s
RICR page and not the PDF of the Rule to avoid continuity issues if/when
the linked Rule is amended.

All watermarks and page numbers must be removed prior to submitting for final
review.

1.1.3 Working with the RICR Template and Microsoft Word
A.

B.

Download the RICR Template
1.

Download the RICR template from: http://sos.ri.gov/divisions/opengovernment/state/Rules-and-Regulations.

2.

Save the template on your local drive.

3.

The RICR template contains all RICR styles necessary to format your
document correctly.

How to Display the Style Area in the Document Window
1.

You can quickly verify which RICR style has been applied to each heading
or paragraph by displaying the “Style Area” pane in Outline or Draft view
as well as opening the “Navigation” pane to the left of your document.
a.

The “Navigation” pane can be found by under the “View” tab where
you can then click the “Navigation Pane” checkbox in the “Show”
box.

b.

To locate the “Style Area” pane in Office 2010 and later (except
Outlook):
(1)

Click “File.”

(2)

Click “Options.”

(3)

Click “Advanced.”

(4)

Change the “Style area width” to one inch (1”) and click OK at
the bottom of the “Word Options” window.

(5)

You can change views at any time by clicking the “Draft
View” icon in the “View” menu at the top of the screen.

(6)

If you open Outline or Draft view, the pane will now be
visible.
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C.

Display Styles Window
1.

D.

Styles can also be applied from the “Style” window. To display the
“Styles” window:
a.

Click on the small arrow at the bottom right corner of the
“Styles” block of the ribbon that displays when you select the
“Home” tab.

b.

The “Styles” window will open to the right of your document.

Turning off auto-numbers and auto-bullets. You must turn off auto-numbers and
auto-bullets as both need to be manually keyed in Rules documents. To do so
in Office 2010 and later (except Outlook):
1.

Click “File.”
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E.

F.

2.

Click “Options.”

3.

Click “Proofing.”

4.

Click “AutoCorrect Options.”

5.

Select “AutoFormat As You Type.”

6.

Deselect “Automatic Bulleted Lists” and “Automatic Numbered Lists.”

Pasting Rule Text into the RICR Template
1.

Open your Rules document.

2.

Select all the text (Ctrl + A) and copy (Ctrl + C).

3.

Close the document.

4.

Navigate to the RICR Template saved on your local drive and open it.

5.

Paste your text (Ctrl + V) into the new document.

6.

Save as a .doc or .docx file with a new name.

7.

You can now begin to type new text or copy and paste text from an
existing document, and then apply the RICR Template styles.

Creating Proposed Rule Documents and Applying RICR Styles to the Text
1.

2.

Track Changes Method: To create a Proposed Rule document, you can
use the Track Changes feature in Word.
a.

Track Changes can be found on the “Review” tab ribbon. Select it
to turn it on.

b.

After completing the changes save your document as a .doc or a
.docx file.

Manual Method: Some agencies prefer not to use Track Changes and to
manually create a Proposed Rule document. Underline should be used to
indicate newly added language and strikeout should be used to indicate
removed language. Although not required, you may also exhibit changes
to the Rule in a font color other than black for the benefit of readers. To
manually strikeout text:
a.

Select the text and then click on the bottom right corner of the
“Font” block of the “Home” tab ribbon.

b.

When the window opens, click the “Strikethrough” checkbox and
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close the window.
c.
G.

In more recent versions of Word, the strikethrough icon appears
on the “Home” tab ribbon next to the underline button.

Creating Final Rules Documents and Applying RICR Styles to the Text
1.

Track Changes Method:
a.

b.

2.

Accept the changes and review the document to make sure all the
changes appear correctly. To accept the changes, go to the
“Review” tab in Word and click “Accept” for each change.
(1)

If you know you want to accept all changes in the document,
select “Accept All Changes and Stop Tracking” from the
drop-down menu.

(2)

Formatting changes are not required to be displayed on a
Proposed Rule. In order to clear only formatting changes,
click “Show Markup” under the “Review” tab and uncheck all
options except for “Formatting.” You may then click the dropdown menu under “Accept” and select “Accept All Changes
Shown” to only clear the changes that are displayed at that
time.

Save your document as a Word (.doc or .docx) file. When doing so,
be sure to add “Final” to the end of the file name to indicate that it is
a Final Rule.

Manual Method:
a.

b.

Use the “Replace” feature found on the “Home” tab ribbon to
remove stricken language.
(1)

After opening the Replace window, place your cursor in the
“Find What” field, select the “More” button and then select
“Format” and “Font.”

(2)

When the “Font” window opens, select “Strikethrough” (while
also ensuring all other boxes are unchecked) and click “OK.”

(3)

Complete the process by selecting “Replace All” and close
the window.

(4)

All stricken text should now be removed.

To change the underlined text to normal font, select all text (Ctrl +
A), then click the underline button twice. The underline button can
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c.
d.

H.

Review and proof your document for accuracy and save the file as
a .doc or .docx file. When doing so, be sure to add “Final” to the
end of the file name to indicate that it is a Final Rule.

Applying Styles to Text
1.

Styles can be applied by displaying the “Styles” pane to the right of your
document. To open this pane, see § 1.1.3I(1).

2.

To apply styles, use one (1) of the following two (2) methods:
a.

b.

I.

be found in the Font block of the Home tab:
. You can also use
the shortcut key (Ctrl + U) to perform this function.
All the text should now be changed to Arial font.

Select a style and insert new text.
(1)

Choose the style you would like to use.

(2)

Type your text or insert Unformatted Text or Formatted Text
(RTF) from another document using “Paste Special,” which
can be found under the drop-down menu below the “paste”
button on the “Home” ribbon.

(3)

The style chosen applies to all text inserted from that point
forward.

(4)

REMEMBER: Pasting as “Unformatted Text” will remove all
bold, italics and underlines.

Apply a style to existing text.
(1)

Click anywhere in a paragraph or heading, or highlight
(select) the text to be styled.

(2)

Click on the style you would like to apply.

(3)

The style chosen applies to all text in the paragraph or
heading up to the point of the first hard return, or all
highlighted or selected text, which allows you to select more
than one (1) paragraph.

(4)

REMEMBER: No matter what heading the text of the Rule
falls under, whether the text is under a heading 1.1 or a
heading 4.1, always start the text of the Rule using the
RICR Paragraph 1 style.

Numbered Paragraphs
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1.

For numbered paragraphs:
a.

Select the RICR paragraph style you would like to use, depending
on the level of the paragraph.

b.

You will need to manually number paragraphs. Type the paragraph
number, (using either a period after the number of parenthesis
before and after, as appropriate) then insert a tab.

c.

Type or insert the text of the paragraph.

1.1.4 Style a Table in Word
Create tables using Word’s Table feature found on the “Insert” tab. If possible,
avoid using partial borders. You can use borderless cells and shading in your
tables. All tables should use the RICR text style.
1.1.5 Graphics
A.

When filing documents with the Department of State you may leave maps and
figures embedded in your Rules documents.

B.

Graphics and large tables can be presented in landscape view for better
appearance and usability.

C.

Figures, graphics, and tables should be treated as paragraphs and
subparagraphs using the appropriate RICR styles. The title of the figure, graphic,
or table should be styled at the appropriate level. The actual figure, graphic, or
table should be styled as if it were text below the paragraph-level style. Always
make sure the figure, graphic or table is set to “In Line with Text” formatting.
1.

Example:
a.

D.

Structural Shoreline Protection Standards for Coastal Greenways

When inserting an image into your Rules document you should provide Alt Text
for the image so it accessible to those utilizing assistive technologies to access
your Rule. Inserting Alt Text for your image:
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1.

Right-click on the image and select “Edit Alt Text.”

2.

Enter the Alt Text for that image.
a.

Alt Text example:
(1)

C=

(2)

Carcinogenic Substances – Industrial/Commercial
Algorithm for Carcinogens in Soil

 RISK x AT x CF   BW a 
x

 

 CPSo x EF   ED x IRSa 
Alt Text: Industrial/Commercial Algorithm for Carcinogens in
Soil. For more information, contact [insert contact
information where the full formula can be requested].
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1.1.6 Definitions
A.

Use the following guidelines for formatting definitions:
1.

Place definitions towards the beginning of the Rule.

2.

Arrange the words or terms in alphabetical order.

3.

Capitalize the first letter of the first word in each definition. All subsequent
words in each definition should be lowercase unless those words are
proper nouns.

4.

Place the word or term being defined within quotation marks.

5.

Immediately after the word or term being defined, insert the word “means.”

6.

Avoid using dashes, slashes or parentheses in a term being defined. For
example, use “Individualized education plan” or “IEP” means… instead of
“Individualized education plan (IEP)” means....

7.

Definitions are not required to have individual paragraph letters UNLESS
the Definitions section uses more than one (1) RICR paragraph level. If
your Definitions section begins with an introductory clause (e.g., “For the
purposes of this Rule, the following terms are defined as follows:”), you
must use paragraph designations in the entire section.

1.1.7 Citations
A.

The purpose of this section is to provide a uniform system of citation to agencies
when revising/reformatting their Rules through the APA recodification process.

B.

What is outlined below is a uniform citation which takes into account:

C.

1.

Ease for the non-lawyer reader;

2.

Ease for the non-lawyer agency drafter;

3.

Ease for the out-of-state reader;

4.

How other states cite to materials in their Rules; and

5.

The requirements of the Rhode Island APA.

Incorporation by Reference versus Citation
1.

Before you can cite to the material, you need to identify what type of
material you are citing and whether you are incorporating it by reference.
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a.

Incorporation by Reference
(1)

Federal Regulations
(AA) The Rhode Island Administrative Procedures Act
(APA) allows agencies to incorporate Federal
Regulations by reference. This includes materials
properly incorporated by reference in federal
regulations. Incorporation by reference is a drafting
tool which allows agencies to give legal effect to
Federal Regulations to allow for state level
enforcement without publishing the regulation in full.

(2)

Scientific/Technical Materials
(AA) The Rhode Island APA also allows agencies to
incorporate “published codes, standards or guidelines
of any nationally recognized scientific or technical
association or organization” which is “regularly in the
business of developing scientific or technical
standards or guidelines, is recognized by those in the
relevant professional community as having a high
degree of expertise and competence in its field, and
whose publications are widely distributed and easily
available throughout the nation and the state of
Rhode Island.” [R.I. Gen. Laws § 42-35-3.2]
(BB) This is a drafting tool which allows an agency to give
a code, standard or guideline of such an organization
full legal effect (full force of law) so that the agency
can then enforce compliance with that code, standard
or guideline.

(3)
b.

NOTE: You cannot cite or incorporate guidance
documents, agency policy, or agency guidelines.

Citations
(1)

State and Federal statutes already have the force of law
behind them and therefore you need not incorporate them
formally, you can simply reference them. State of Rhode
Island Regulations that have been properly promulgated
are analogous to state statutes in that they already have the
force of law behind them on a statewide level. As such, they
can be referenced without formally incorporating them into
the Rule. This is a particularly helpful tool to avoid
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conflicting Rules.
c.

Quick Reference Guide:
(1)

You can only incorporate the following by reference:
(AA) Code of Federal Regulations
(CFR) or United States Code
(USC);
(BB) Materials properly incorporated in Federal
Regulations; or
(CC) Codes, standards or guidelines published by
nationally recognized scientific or technical
organizations.

(2)

You can only cite to the following sources without formally
incorporating them by reference:
(AA) Rhode Island statute;
(BB) Rhode Island Regulation (which has already
been properly promulgated); or
(CC) Any Federal statute.

D.

How to Cite Materials
1.

How to Cite to a Federal Statute
a.

Full Citation:

b.

Short Citation:
42 U.S.C. § 9601.

Nellie M Gorbea – Secretary of State

16 | P a g e

2.

How to Cite to a Rhode Island Statute

a.

2.

NOTE: You can find the “Section” symbol (§) in Word under “Insert”>
“Symbol” > “Special Characters” You can create a shortcut key to
quickly access the § symbol if you will be using it frequently.

How to Cite to a Rhode Island Regulation
a.

When citing to a different Title:

b.

Citing within the same Part

c.

(1)

Citing to a Section within a Part: § 7.2 of this Part.

(2)

Citing to a Subsection within a Part: § 7.2(A) of this Part.

Citing within the same Subchapter
(1)

Citing to a Part within the same Subchapter: Part
7 of this Subchapter.

(2)

Citing to a Section within the same Subchapter: §
7.2 of this Subchapter.
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(3)
d.

e.

f.

E.

Citing to a Subsection within the same Subchapter:
§ 7.2(A) of this Subchapter.

Citing within the same Chapter:
(1)

Citing to a Subchapter within the same Chapter: Subchapter
15 of this Chapter.

(2)

Citing to a Part within the same Chapter: Subchapter 15
Part 7 of this Chapter.

(3)

Citing to a Section or Subsection within the same Chapter: §
15-7.2(A) of this Chapter.

Citing within the same Title
(1)

Citing to a Chapter within the same Title: Chapter 20 of this
Title.

(2)

Citing to a Subchapter within the same Title: Subchapter 2015 of this Title.

(3)

Citing to a Part within the same Title: Part 20-15-7 of this
Title.

(4)

Citing to a Section or Subsection within the same Title: § 2015-7.2(A) of this Title.

NOTE: If you are citing a Rule that has not been filed in the RICR,
use the title of the Rule enclosed by quotation marks (e.g.
“Department of Health Rules and Regulations Regarding Health
Care Workers”). Once the Regulation is filed in the RICR, the
citation can be changed via technical revision.

How to Incorporate A Material by Reference
1.

Step by Step Guide for Incorporation by Reference
a.

Step One: Create an “Incorporated Materials” Section. We
recommend that this comes between the “Authority” and
“Definition” sections of the Rule.

b.

Step Two: Create a subsection for each material you wish to
incorporate by reference.

c.

Step Three: Add language “These Regulations hereby adopt and
incorporate [insert citation] by reference, not including any further
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editions or amendments thereof and only to the extent that the
provisions therein are not inconsistent with these Regulations.”

2.

d.

Step Four: Insert citation in the format described in §§ 1.1.7(F)
through (G) below.

e.

NOTE: If the material is not considered a Federal Regulation, a
material properly incorporated by reference in a Federal
Regulation or a scientific/technical material, it cannot be
incorporated by reference.

Example of Incorporated by Reference Section with Correct
Citations:

a.

NOTE: You can cite to the incorporated material in the body of
your Regulation by referencing the Incorporated Materials
subsection.
(1)

Examples:
(AA)

Phlebotomists must maintain their syringes in the
manner prescribed in “Standards for taking Blood
Samples,” incorporated above at § 3.3(B) of this
Part.

(BB)

Geologists must mine for diamonds in accordance
with “National Geological Society Guidelines for
the Safe Gemstone Excavation”, incorporated
above at § 3.3(C) of this Part.
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F.

Creating Citation for Incorporation of Federal Code of Regulations by
Reference

1.

G.

Give the name of the Regulation only if the Regulation is commonly
cited that way:

a.

NOTE: You can include hyperlinks to Federal Regulations within
your Regulation document.

b.

NOTE: You should be incorporating the most recent version of the
C.F.R. If you have previously referenced a C.F.R. from a prior year,
changing the year will be a substantive change that should be
marked by track changes.

c.

NOTE: The year is required for all materials incorporated
by reference.

Creating Citation for Incorporation of Scientific/Technical Materials by
Reference
1.

The Rhode Island APA requires that the reference include the name of the
association or organization, the title of the material and the date of the
material. You may also include a link to the material, if applicable.

1.1.8 Troubleshooting Formatting Problems
A.

Occasionally, when you open a document, the text may appear to have lost the
styles you have applied. If that happens, try Copying and Pasting into a new
Template Document:
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B.

1.

Select all the text (Ctrl + A) and copy it (Ctrl + C).

2.

Close the document.

3.

Navigate to the RICR template saved on your local drive and open it.

4.

Paste your text (Ctrl + V) into the new document.

5.

Save as a .doc or .docx file with a new name.

Turning off style restrictions in the RICR Template
1.

Pop the Style window out to anchor on the right side of your document by
clicking on the small box at the bottom right of the Style ribbon.

2.

Click on Manage Styles button.

3.

Click “Restrict” tab and unclick “Limit Formatting” to permitted styles
check box, and then click “OK.”
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4.

C.

You can always turn the restriction back on following the same steps and
clicking Limit formatting to permitted styles, click “OK.” When you turn
the Restriction back on you will receive a pop-up box. You do not need
to enter a password, just click “OK.”

Importing RICR Styles into any Word document
1.

Open the document you want to import style to in Word then
click “File,” followed by “Options,” followed by” Custom Ribbon” to add
the Developer on to the ribbon.
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2.

Click “Document Template” under the Developer Tab. In the pop-up
dialog box, click “Organizer.”

3.

There will be another popup dialog box. Click “Close File” on the right.

4.

Click “Open File” and select RICR-Template.docx (you may have to
change the file type to “All Files”), then click “Open.”
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5.

After opening RICR-Template.docx, you can select the RICR styles in
the right box and click Copy. This will copy the style to the left box.

6.

After copying the styles to the left box, click Close. The style importing is
finished.

1.1.9 RICR Classification System
A.

The Rhode Island Code of Regulations (RICR) is a classification system that
orders Regulations by agency. Each agency is then organized into chapters,
subchapters, and parts.

B.

The RICR has four (4) major divisions:
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1.

Title: Agency name.

2.

Chapter: A core function of the agency. Some smaller agencies may
not need to give a name to this level, but it is required and will be
labeled 00 if a name is not supplied by the agency.

3.

Subchapter: Topic area within a core function of the agency. Larger
agencies may need to name these additional levels; it is required and
will be labeled 00 if a name is not supplied by the agency.

4.

Part: A set of Rules on a specific topic.

Title
(Agency)
100
Citation

TITLE
250-

Code

Dept. of
Business
Regulation

Part
(Rule)

Section

10

05

1

.1(A)(1)(a)
((1))

PART

SECTION

100-RICR-10-05-1.1(A)(1)(a)((1))
EXAMPLES
CODE
RICR-

RICR-

Dept. of
Health

230-

Subchapter
(Topic)

RICR

Dept. of
Environmental
Management

216-

Chapter
(Function)

RICR-

CHAPTER

SUBCHAPTER

40-

05-

4

.8

Agriculture
and Resource
Marketing

Animal Health

Rules and
Regulations
Governing
Animal Care
Facilities

Species
Specific
Standards

50-

10-

6

.3.1

Environmental
Health

Food Protection

Processing
and
Distribution of
Shellfish

License
for a
Shellfish
Business

30-

20-

2

.2(A)(3)

Commercial
Licensing

Real Estate

Real Estate
Brokers and
Salespersons

“Clock
hour”
definition
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C.

Title
This classification level represents state agencies. These include general
officers, executive branch agencies, boards and commissions, and quasi-public
agencies with specific rulemaking authority granted by R.I. Gen. Laws. The
numbering scheme begins with 100 and increases by multiples of 2, 5 or 10
based on the entity type and its relationship to other entities in the Code. The
three-digit indicator allows for growth over time, including the placement of new
agencies near related agencies in the code (e.g., EOHHS is 210, with subagencies represented by 212, 214, etc.).

D.

Rhode Island Code of Regulations (RICR)
The four-letter code “RICR” indicates a Regulation published in the official
Rhode Island Code of Regulations.

E.

Chapter
This classification level represents major agency functions. Agencies will
distinguish between functions by assigning chapter numbers using a skip 10
method (e.g., 10, 20, 30…110, etc.). The skip method allows room to insert new
functions near related functions in the future. Agencies may use 00 if there is no
need to differentiate a topic.

F.

Subchapter
Agencies can use this level to organize functions by topic area if necessary.
Agencies will assign subchapter numbers using a skip five method (e.g., 05, 10,
15, etc.). Agencies may use 00 if there is no need to differentiate a topic.

G.

Part
A Part represents an individual Rule regulating a specific topic. Parts are
assigned using a skip one method (e.g., 1, 2, 3, 4, etc.).

H.

Section Levels
1.

A section represents the individual headings that make up a Part. Sections
are divided into six (6) levels:
a.

RICR Heading 1 – (ex. .1, .2, .3, .4,
etc.)

b.

RICR Subheading/Subchapter – (ex.
.1.1, .1.2, .1.3, .1.4, etc.)

c.

RICR Par 1 – (ex. A., B., C., D., etc.);
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d.

RICR Par 2 – (ex. 1., 2., 3., 4., etc.);

e.

RICR Par 3 – (ex. A., b., c., d., etc.); and

f.

RICR Par 4 – (ex. (1), (2), (3), (4), etc.).

NOTE: Agencies should make every attempt
to limit the number of subsection levels to no
more than six (6) levels to reduce regulatory
volume while maintaining readability. In the
rare cases where additional levels are
required, there are two (2) additional levels
available to handle these exceptions. The
additional two (2) levels are:
g.

RICR Par 5 (ex. (AA), (BB), (CC),
(DD), etc.).

h.

RICR Par 6 (ex. (i), (ii), (iii), (iv), etc.)
(1)

I.

There are no additional levels
beyond RICR Paragraph 6.

Additional Rules Surrounding Code Design
1.

Decimal points are not allowed at the Title, Chapter, Subchapter
or Part level.

2.

Parts cannot be renumbered to accommodate repealed Rules.

1.1.10 RICR Code Structure
All questions related to Title designations should be directed to the
Department of State’s Administrative Records Office.
Title
Number
100
110
120
130
152
160
170
180
200

Agency
Department of State
Attorney General
Treasury Department
Auditor General
Unauthorized Practice of Law Committee
Permanent Joint Committee on Legislative Services
Executive Office of Commerce
The Office of Veterans Affairs
Board of Education
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210
212
214
216
218
220

455
460
465
470
475
480

Executive Office of Health and Human Services
Department of Behavioral Healthcare, Developmental Disabilities and Hospitals
Department of Children, Youth, and Families
Department of Health
Department of Human Services
Department of Administration
Department of Business Regulation (includes the Office of the Health Insurance
Commissioner)
Department of Corrections
Parole Board
Batterer’s Intervention Program Standards Oversight Committee
Department of Environmental Management
Department of Labor and Training
Department of Public Safety
Department of Revenue
Department of Transportation
Office of Energy Resources
Board of Accountancy
Board of Certification of Operators of Wastewater Treatment Facilities
Board of Elections
Board of Examination and Registration of Architects
Board of Examiners of Landscape Architects
Board of Medical Licensure and Discipline
Board of Registration for Professional Engineers
Board of Registration for Professional Land Surveyors
Contractors’ Registration & Licensing Board
Energy Facility Siting Board
Fire Safety Code Board of Appeal and Review
Governor’s Workforce Board (formerly known as Human Resource Investment
Council)
Labor and Training Board of Review
Labor Relations Board
Motor Vehicle Arbitration Board
Personnel Appeals Board
State Housing Appeals Board

490

Water Resources Board

500
505
510
515
520
525
530
545

Advisory Commission on Historical Cemeteries
Agricultural Lands Preservation Commission
Building Code Commission
Commission for Human Rights
Ethics Commission
Governor’s Commission on Disabilities
Historical Preservation & Heritage Commission
Judicial Nominating Commission

230
240
242
244
250
260
270
280
290
300
400
405
410
415
420
425
430
435
440
445
450
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550
555
600
650
660
665
670
800
805
810
815
820
825
830
835
840
845
850
855
860
865
870
875
880
885

State Traffic Commission
Vehicle Value Commission
State Properties Committee
Coastal Resources Management Council
Rivers Council
State Council on the Arts
State Planning Council
Airport Corporation
Capital Center Commission
Public Utilities Commission
Division of Public Utilities and Carriers
Health and Educational Building Corporation
Housing and Mortgage Finance Corporation
Infrastructure Bank
Narragansett Bay Commission
Public Transit Authority
Resource Recovery Corporation
Student Loan Authority
Turnpike and Bridge Authority
Housing Resources Commission
I-195 Commission
Commerce Corporation
Industrial Facilities Corporation
Quonset Development Corporation
East Providence Waterfront District

1.2

General Filing Information

A.

This section’s purpose is to guide agencies on the mechanics of filing
Rules and Regulations with the Department of State using the RICR
Filing Application.

B.

For guidance on writing state Regulations, please refer to the Office
of Management and Budget Rhode Island Administrative Procedures
Act Regulatory Manual and related documents, found at
www.omb.ri.gov/reform.

C.

In the RICR Filing Application you will complete your public notice
using the online form and, after review, will generate and publish the
notice as a .pdf to the RICR website.
1.

The red asterisk (ex. Rulemaking Authority: *) next to a section of
the form denotes a required field.

2.

The
signals a tool tip over which you can hover with your
cursor to provide helpful explanations for fields and terms used
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in the application.
D.

The legend for the icons used in the RICR application is as follows:
- New Adoption
New Amendment
New Repeal
New 60-day Emergency Renewal

Advance Workflow
Start Rulemaking (After Advance Notice of Proposed
Rulemaking)
Terminate
Upload Documents
Review Documents/Generate Notice
Edit Promulgation
Review Filing/ Review Public Comments

E.

The steps of the proposed regular rulemaking process are as follows [users who
perform this step are noted in brackets]:
1.

Initial Data Entry and Documents Upload [Rules Coordinator, Agency Head,
or Filer];

2.

DOS Verification of Drafts [SOS Admin];

3.

Generation of the Notice of Proposed Rulemaking [Rules Coordinator,
Agency Head, or Filer];

4.

Submission for Promulgation [System];

5.

Public Comment Period Begin [System];

6.

Post Public Comment Period Data Update and Document Upload [Rules
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Coordinator, Agency Head, or Filer];

1.3

7.

DOS Final Regulation Approval [SOS Admin];

8.

Agency Head Signature Applied [Agency Head];

9.

Final Rule and Signature Acceptance by DOS [SOS Admin]; and

10.

Promulgation Finalization [System].

Adoption Procedures

1.3.1 Initial Data Entry and Documents Upload
A.

Go to the RICR application login page at: https://rules.sos.ri.gov/login and
provide your login credentials.

B.

Make sure you have the “Current Rules” tab opened at the top of the screen.
Click on: “+ [###- Title Name]” to expand the listing to show all available
Chapters.

C.

Click on “+ [###- Chapter Name]” to expand the listing to show all available
Subchapters.

D.

Click on the blue button for “New Adoption” next to “+ [###- Subchapter Name]”.
1.

NOTE: The “New Adoption” button will be green if the Department of State
has added an APA exemption to the Subchapter.

2.

NOTE: If your Subchapter has not been given a name, you can still click the
+ symbol or the numbers 00 to expand the listing to show all effective
Parts.

E.

Click on the radio button to select “Proposed” for the Rulemaking Action.

F.

Click on the appropriate radio button for the “Rulemaking Process: *” Either
select “Regular” or “Direct Final”.

G.

Enter the Part number of your choice in the text field for “Rule Identifier: *”
1.

NOTE: This must be a new Part number not already in use for this Title-
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Chapter- Subchapter. A Part number cannot be reused if a filing was
terminated after publishing a Proposed Rule under the Subchapter.
H.

Enter the name of the Regulation in the text field for the “Regulation Title: *.”

I.

Select either “R.I. General Laws” or "Alternative" as the selection in the dropdown menu in “Rulemaking Authority: *” and enter the appropriate citation in the
empty text box and then click on the blue “Add >>” button. You may do this
action as many times as necessary to list all the applicable statutory authorities
for your adoption.
1.

When "R.I. General Laws" is selected, you only need to put in the actual
numbers of the citation with appropriate hyphens (ex. 42-35-1). The
application will build the rest of the citation for you.

2.

If you are citing a whole Chapter or Title in the R.I. General Laws, you
will want to select “Alternative” and write out the citation in full, as
selecting “R.I. General Laws” automatically adds a section symbol to all
entries.

J.

In plain language, provide a statement of the subject matter of the Proposed
Rule. You should include the terms or substance of the intended action or a
description of the issues involved. Include a summary of any non-technical
changes between the current and Proposed Rule in the “Summary of Proposed
Rule: *” field by typing or by cutting and pasting from an existing document.

K.

Provide a brief paragraph regarding the societal cost and benefits and cost of
compliance as prepared under R.I. Gen. Laws § 42-35-2.9. Include any citations
to scientific or statistical studies, reports, or analyses that served as a basis for
the Proposed Rule in the “Regulatory Analysis Summary and Supporting
Documentation: *” field by typing or by cutting and pasting from an existing
document.

L.

Enter the web address for the location on your website where the Notice of
Proposed Rulemaking and summary of the regulatory analysis are published
in the “Additional Information URL: *” field.

M.

Click the blue “Submit” button at the bottom of the page.

N.

Click the blue “Upload Documents” button.

O.

Select “Proposed Rule” from the “Document Type” drop-down menu.
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P.

Click on “Choose File” or "Browse" button (depending on your browser) and
select the Word document containing the Proposed Rule with new
language clearly marked using underline formatting. For an adoption, all
text is considered new and therefore, all text should be underlined.
1.

Q.

NOTE: The Proposed Rule must be in .doc or .docx format, all other
document formats are not accepted.

Click the blue “Upload Document” button. You can continue to upload additional
documents, if you wish, by clicking "Upload More Documents."
1.

NOTE: Additional Documents may be in one of the following formats:
•
.doc
•
.docx
•
.jpg
•
.jpeg
•
.xlsx, or
•
.pdf

R.

Click the blue “Home” button.

S.

You can now review the Proposed Rule you uploaded under the "Text" tab on
the right side of the screen. You can use this feature to check your work and
make sure the RICR styles from the template are correctly applied. This is also
an easy way to check the numbering in your Rule.

T.

To submit for review by the Department of State (DOS): Under the “Work Queue”
tab, click on the
icon next to the title of the Rule you just proposed to adopt to
Advance the Workflow. On the next page, click the green “Advance” button.

U.

A notification will appear regarding the Office of Regulatory Reform’s review of
this filing. If you have received ORR approval, click “Yes.”

V.

Provide any necessary notes to the Department of State staff in text fields for
“Outcome Note” and “Request Note” (both optional).
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W.

Click the blue “Submit” button at the bottom of the screen.

X.

Click “OK.” Your submission will be forwarded to the Department of State for
formatting review. Please note the Department of State may take up to five (5)
business days to review and advance or reject your filing.

1.3.2 Generation of the Notice of Proposed Rulemaking & Submission for
Promulgation
A.

When your Rule is ready for you to generate your public notice of proposed
rulemaking, you will receive an AWS notification stating that this step is ready
for your action.

B.

At this time, you may upload additional documentation to be published with
this Rule. For more information on this process, see § 1.3.1(Q) above after
clicking the “Upload Document” icon
next to the Rule in your Work
Queue.

C.

You can also edit the details of your filing by clicking the “Edit” icon
from
your Work Queue. Several fields will no longer be editable at this time.

D.

Under the “Work Queue” tab at the top of the screen, expand the
Title>Chapter>Subchapter to view your proposed adoption and click
on
to generate the Notice of Proposed Rulemaking and publish your proposed
adoption to the RICR website.

E.

Click on the “Add>>” button under “Add a Public Comment Period.”

F.

The Date of Public Notice will automatically be set to the date you generate the
notice. Click on the text box below “Date of End of Comment Period” and select a
valid date for the end of comment period. The application will automatically
calculate thirty (30) days from the date you generate the notice; however, you
may select a later date.
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G.

Enter the name of the person designated to receive comments for this filing in the
“Full Name of Contact Person” text box.

H.

Enter the email address of that individual in the “Contact Person Email” text box.

I.

Enter the physical address where you would like the public to direct comments in
the “Contact Person Address” lines.

J.

Click on the appropriate radio button to indicate whether you will be accepting
online submission of public comments under “Allow online public comments?”
1.

If you select “Yes,” you must then indicate the dates during which you
will accept comments through the RICR. These dates will automatically
be pre-set to match the public comment period you indicated in your
notice; however, you may elect to accept online comments for any span
between the dates of the public comment period.
•

NOTE: If you select “No,” you are still required to accept public
comments outside of the RICR.

K.

Click “OK.”

L.

If you will be having a Public Hearing, complete these additional steps:
1.

NOTE: If you chose Direct Final rulemaking, this option is not available.

2.

In the text box to the right of the first “Add >>” button, click on the dates for
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the public comment period you just entered.
3.

Click on the “Add >>” button under the “Add a Public Hearing” section.

4.

Click the text box under “Hearing date/time.” The application will
automatically calculate all available dates ten (10) days after the
beginning of your comment period and five (5) days before the end of
that comment period. Select a hearing date.

5.

Click the dropdown box next to “Time:” and select a time and “AM” or
“PM.”

6.

Enter text into the fields under “Hearing Location:” marked “Address Line
1”, “City” and “Zip code.”
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7.

Enter the phone number for the Special Assistance contact in the “Phone
Number for Special Assistance” text box. You are not required to enter an
extension, but you may.

8.

Click “OK.”

M.

Click on the blue “Generate Notice” button at the bottom of the screen.

N.

You will now be able to review the public notice you just created before
publishing your Rule. Review your notice. If you approve, click “Publish.” If
you wish to make changes, press “Cancel” to return to the previous screen.

O.

Upon clicking “Publish,” you will receive confirmation and a list of documents
now available on the public-facing RICR application.

P.

If you wish to amend the notice you just published, you can click “Amend Public
Notice” or click “Home” to return to your Work Queue.

Q.

When the notice is published, you will receive an AWS notification informing you
of the publication.
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1.3.3 Post Public Comment Period Data Update and Document Upload

A.

Under the “Work Queue” tab at the top left of the screen, expand the
“Title>Chapter>Subchapter” to view your proposed adoption. If you opted to
accept public comments online through the RICR during the public comment
period, click the
icon to review submitted online public comments. You
must review all public comments before advancing the workflow to the next
step. For tips on reviewing public comments submitted online through the
RICR, see § 1.7 of this manual.
1.

B.

Click on
Upload Documents next to the proposed adoption that has
completed the public comment period. Download the .doc or .docx version of the
Proposed Rule last uploaded by Department of State staff. Use this version to
accept all proposed changes and make additional edits to the Rule. This will
facilitate a more efficient review at the final step of the rulemaking process.
1.

C.

NOTE: You may review online public comments at any time throughout
the public comment period as well as once it concludes.

NOTE: If the Final Rule requires approval from the Office of Regulatory
Reform (ORR), you must receive this before completing the following
step.

Click the drop-down menu under “Document Type:” and select “Final Rule” from
the drop-down menu.
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D.

Click on “Choose File” or “Browse” (depending on your browser) and select the
final, clean Word document (.doc or .docx) for the proposed adoption (final text
of the Rule, no underlined or struck-through text) and click on the blue “Upload
Document” button (Required).

E.

Click the blue “Upload More Documents” button to return to the document
upload page. “Final Rule” will now have a green checkmark indicating it was
uploaded successfully.

F.

On the document upload page, under “Document Type,” select “Public
Comment” from the drop-down menu.

G.

Click “Choose File” or "Browse" (depending on your browser) and select the
document containing a copy of all comments received – or a statement that
no comments were received - and click on the blue “Upload Document”
button. You may upload additional Public Comment documents, if needed
(Required).
1.

You do not need to upload copies of any comments received online
through the RICR as the application will file those on your behalf.
•

2.

NOTE: If you only received online comments for this filing,
you may upload a report of those comments by clicking the
“Print” button on the online comment review page and
saving the pdf of the report that is generated.

If you considered any comments received inappropriate for public display,
those comments should still be kept with the rulemaking file. If the
comment was received online through the RICR, this process is
complete. If the comment was received by other means, you will need to
maintain a copy with your files for this rule.

Nellie M Gorbea – Secretary of State

39 | P a g e

H.

Click the blue “Upload More Documents” button and under “Document Type”
select “Concise Explanatory Statement” from the drop-down menu.
1.

NOTE: The Public Comment document will now have a green
checkmark next to it under the Required Documents list.

I.

Click “Choose File” or “Browse” (depending on your browser) and select your
Concise Explanatory Statement. Click “Upload Document.” A template for this
document can be found at § 1.15, Appendix 5 (Required).

J.

If necessary, click the blue “Upload More Documents” button and under
“Document Type” select the appropriate document type(s) from the drop-down
menu:
1.

Internal Organization Document (See R.I. Gen. Laws § 42-35-2.3(b)(9))

2.

Public Hearing Documents (See R.I. Gen. Laws § 42-35-2.3(b)(5))

3.

Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))

4.

Index of Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))

5.

Petition seeking agency action for this Rule (See R.I. Gen. Laws § 4235- 2.3(B)(8))

6.

Additional Documentation

7.

State Register Publications (See R.I. Gen. Laws § 42-35-2.3(b)(1))

K.

Click the blue “Home” button.

L.

To submit for review by the Department of State (DOS):
1.

Under the “Work Queue” tab, click on the green icon
the Rule being proposed to Advance Workflow.
•

2.

M.

next to the title of

NOTE: This icon will only be available once all required documents
have been uploaded. If this icon is not available, check to ensure
you have uploaded all required documents.

On the next page, click the green “Advance” button.

A notification will appear regarding the Office of Regulatory Reform’s review of
this filing. This applies to regular rulemaking only. If you have received ORR
approval, click “Yes.”
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N.

Provide any necessary notes to the Department of State staff in the text fields for
“Outcome Note” and “Request Note.”
1.

If this Rule should become effective any later than the typical twenty (20)
days after filing (for Regular Proposed Rules) or the end of the public
comment period (for Direct Final Rules), please leave a note for the
Department of State in the “Request Note” field with the date you would like
this Rule to be effective.

O.

Click the blue “Submit” button at the bottom of the screen.

P.

Click “OK.” Your submission will be forwarded to the Department of State for
formatting review. Please note the Department of State may take up to five
(5) business days to review and advance or reject your filing.

1.3.4 Agency Head Signature Applied
A.

Once the Department of State completes the format review and advances the
workflow, an email notification will be sent to the designated Agency Head from
OneSpan requesting his or her e-signature. The message will state, “The APA
System has added you as a Signer to “XXX-RICR-XX-XX-XX Title of
Regulation.”

B.

Once the agency head clicks the blue “Go to Documents” button in the
OneSpan notification email, he or she will be directed to the secure e-signature
site. The agency head must accept OneSpan’s consent and disclosures before
clicking the marked box to affix his or her digital signature.

C.

OneSpan will securely forward the digitally signed document to Department of
State staff for final processing. Once the document is fully signed and processed,
the Agency Head will receive email confirmation that the e-signing process has
been completed.
1.

1.4

The full e-signature procedures are laid out in the Guide for Agency
Heads, a copy of which is included at § 1.18, Appendix 9.

Amendment Procedures

1.4.1 Initial Data Entry and Documents Upload:
A.

Go to the RICR application login page at: https://rules.sos.ri.gov/login and
provide your login credentials.
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B.

Make sure you have the “Current Rules” tab opened at the top of the screen.
Click on: “+ [Title Name]” to expand listing to show all available Chapters.

C.

Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D.

Click on “+ [Subchapter Name] to expand listing to show all available Parts.

E.

Click on the

F.

Click on the radio button to select “Proposed” for the Rulemaking Action.

G.

Click on the appropriate radio button for the “Rulemaking Process: *”. Either
select “Regular” or “Direct Final”.

H.

Verify the name of the Part is correct in the field marked “Regulation Title: *”.
1.

I.

icon next to the Part you wish to amend.

NOTE: The Rule Title must match the Title you provided on the Proposed
Rule document.

If you wish to change or amend the rulemaking authority for this Part, select
either “R.I. General Laws” or "Alternative" as the selection in the drop-down
menu in “Rulemaking Authority: *” and enter the appropriate citation in the empty
text box and then click on the blue “Add >>” button. You may do this action as
many times as necessary to list all the applicable statutory authorities for your
adoption.
1.

When "R.I. General Laws" is selected, you only need to put in the actual
numbers of the citation (ex. 42-35-1). The application will build the rest of
the citation for you.

2.

If you are citing a whole Chapter or Title in the R.I. General Laws, you
will want to select “Alternative” and write out the citation in full, as
selecting “R.I. General Laws” automatically adds a section symbol to all
entries.

J.

The summary of Proposed Rule will be pre-populated from the last rulemaking
action for this Part in the “Summary of Proposed Rule: *” field. You may alter this
text as needed.

K.

Provide a brief paragraph regarding the societal cost and benefits and cost of
compliance as prepared under R.I. Gen. Laws § 42-35-2.9. Include any citations
to scientific or statistical studies, reports, or analyses that served as a basis for
the Proposed Rule in the “Regulatory Analysis Summary and Supporting
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Documentation: *” field by typing or by cutting and pasting from an existing
document.
L.

Enter the web address for the location on your website where the notice of
proposed rulemaking and summary of the regulatory analysis are published in
the “Additional Information URL: *” field.

M.

Click the blue “Submit” button at the bottom of the page.

N.

Click the blue “Upload Documents” button.

O.

Select “Proposed Rule” from the “Document Type” drop-down menu.

P.

Click on “Choose File” or "Browse" button (depending on your browser) and
select the Word document containing the Proposed Rule with new
language clearly marked using underline formatting and proposed deletions
using strikethrough formatting.
1.

Q.

Click the blue “Upload Document” button. You can continue to upload additional
documents, if you wish, by clicking "Upload More Documents."

1.

R.

NOTE: The Proposed Rule must be in .doc or .docx format. All
other document formats are not accepted.

NOTE: Additional Documents may be in one of the following formats:
•
.doc
•
.docx
•
.jpg
•
.jpeg
•
.xlsx
•
.pdf

Click the blue “Home” button.

Nellie M Gorbea – Secretary of State

43 | P a g e

S.

You can now review the Proposed Rule you uploaded under the "Text" tab on
the right side of the screen. You can use this feature to check your work and
make sure the RICR styles from the template are correctly applied. This is also
an easy way to check the numbering in your Rule.

T.

To submit for review by the Department of State (DOS): Under the
“Work Queue” tab, click on the
icon next to the title of the Rule you just
proposed to amend to Advance the Workflow. On the next page, click the
green “Advance” button.

U.

A notification will appear regarding the Office of Regulatory Reform’s review of
this filing. If you have received ORR approval, click “Yes.”

V.

Provide any necessary notes to the Department of State staff in text fields for
“Outcome Note” and “Request Note” (both optional).

W.

Click the blue “Submit” button at the bottom of the screen.

X.

Click “OK.” Your submission will be forwarded to the Department of State for
formatting review. Please note the Department of State may take up to five
(5) business days to review and advance or reject your filing.

1.4.2 Generation of the Notice of Proposed Rulemaking & Submission for
Promulgation
A.

When your Regulation is ready for you to generate your public notice of
proposed rulemaking, you will receive an AWS notification stating that this
step is ready for your action.

B.

At this time, you may upload additional documentation to be published with
this Rule. For more information on this process, see § 1.3.1(Q) above after
clicking the “Upload Document”
icon next to the Rule in your Work
Queue.

C.

You can also edit the details of your filing by clicking the “Edit”
icon from
your Work Queue. Several fields will no longer be editable at this time.
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D.

Under the “Work Queue” tab at the top of the screen, expand the
Title>Chapter>Subchapter to view your proposed amendment and click on the
icon to generate the Notice of Proposed Rulemaking and publish to the RICR
website.

E.

Click on the “Add>>” button under “Add a Public Comment Period.”

F.

The date of public notice will automatically be set to the date you generate the
notice. Click on the text box below “Date of End of Comment Period” and select a
valid date for the end of comment period. The application will automatically
calculate thirty (30) days from the date you generate the notice; however, you
may select a later date.

G.

Enter the name of the person designated to receive comments for this filing in the
“Full Name of Contact Person” text box.
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H.

Enter the email address of that individual in the “Contact Person Email” text box.

I.

Enter the physical address where you would like the public to direct comments in
the “Contact Person Address” lines.

J.

Click on the appropriate radio button to indicate whether you will be accepting
online submission of public comments under “Allow online public comments?”
1.

If you select “Yes,” you will then need to indicate the dates during which
you will accept comments through the RICR website. These dates will
automatically be pre-set to match the public comment period you
indicated in your notice; however, you may elect to accept online
comments for any span between the dates of the public comment
period.
•

NOTE: If you select “No,” you are still required to accept public
comments outside of the RICR website.

K.

Click “OK.”

L.

If you will be having a public hearing, complete these additional steps:
1.

NOTE: If you chose Direct Final rulemaking, this option is not available.

2.

In the text box to the right of the first “Add >>” button, click on the dates for
the public comment period you just entered.

3.

Click on the “Add >>” button under the “Add a Public Hearing” section.

4.

Click the text box under “Hearing date/time.” The application will
automatically calculate all available dates ten (10) days after the beginning
of your comment period and five (5) days before the end of that comment
period. Select a hearing date.
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5.

Click the dropdown box next to “Time:” and select a time and “AM” or
“PM.”

6.

Enter text into the fields under “Hearing Location:” marked “Address Line
1”, “City” and “Zip code.”

7.

Enter the phone number for the Special Assistance contact in the “Phone
Number for Special Assistance” text box. You are not required to enter an
extension, but you may.

8.

Click on “OK.”

M.

Click on the blue “Generate Notice” button at the bottom of the screen.

N.

You will now be able to review the public notice you just created before
publishing your Rule. Review your notice. If you approve, click “Publish.” If
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you wish to make changes, press “Cancel” to return to the previous screen.
O.

You will receive confirmation and a list of documents now available on the publicfacing RICR application.

P.

If you wish to amend the notice you just published, you can click “Amend Public
Notice” or click “Home” to return to your Work Queue.

Q.

When the notice is published, you will receive an AWS notification informing you
of the publication.

1.4.3 Post Public Comment Period Data Update and Document Upload

A.

Under the “Work Queue” tab at the top of the screen, expand
“Title>Chapter>Subchapter” to view your proposed amendment. If you opted to
accept online public comments through the RICR website during the public
comment period, click the
icon to review submitted online public comments.
You must review all online public comments before advancing the workflow to
the next step. For tips on reviewing online public comments, see § 1.7 of this
Manual.
1.

B.

NOTE: You may review online public comments at any time throughout
the public comment period as well as once it concludes.

Click on

Upload Documents next to the proposed amendment that has
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completed the public comment period. Download the .doc or .docx version of the
Proposed Rule last uploaded by Department of State staff. Use this version to
accept all proposed changes and make additional edits to the Rule. This will
facilitate a more efficient review at the final step of the rulemaking process.
1.

NOTE: If the Final Rule requires ORR approval, you must receive this
before completing the following step.

C.

Click the drop-down menu under “Document Type:” and select “Final Rule” from
the drop-down menu.

D.

Click on “Choose File” or “Browse” (depending on your browser) and select the
final, clean Word document for the proposed amendment (final text of the Rule,
no underlined or struck-through text) and click on the blue “Upload Document”
button. (Required)

E.

Click the blue “Upload More Documents” button. “Final Rule” will now have a
green checkmark indicating it was uploaded successfully.

F.

On the document upload page, under “Document Type,” select “Public
Comment” from the drop-down menu.

G.

Click “Choose File” or “Browse” (depending on your browser) and select the
document containing a copy of all comments received – or a statement that no
comments were received – and click on the blue “Upload Document” button.
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You may upload additional Public Comment documents, if needed (Required).
1. You do not need to upload copies of any comments received online
through the RICR as the application will file those on your behalf.
•

NOTE: If you only received online comments for this filing, you
may upload a report of those comments by clicking the “Print”
button on the online comment review page and saving the pdf of
the report that is generated.

2. If you considered any comments received inappropriate for public display,
those comments should still be kept with the rulemaking file. If the comment
was received online through the RICR website, this process is complete. If
the comment was received by other means, you will need to maintain a copy
with your files for this rule.
H.

Click the blue “Upload More Documents” button and under “Document Type”
select “Concise Explanatory Statement” from the drop-down menu.
1. NOTE: The Public Comment document will now have a green
checkmark next to it under the Required Documents list.

I.

Click “Choose File” or “Browse” (depending on your browser) and select your
Concise Explanatory Statement. Click “Upload Document.” A template for this
document can be found at § 1.15, Appendix 5. (Required)

J.

If necessary, click the blue “Upload More Documents” button and under
“Document Type” select the appropriate document type(s) from the drop-down
menu:
1. Internal Organization Document (See R.I. Gen. Laws § 42-35-2.3(b)(9))
2. Public Hearing Documents (See R.I. Gen. Laws § 42-35-2.3(b)(5))
3. Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
4. Index of Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
5. Petition seeking agency action for this Rule (See R.I. Gen. Laws § 42-352.3(B)(8))
6. Additional Documentation
7. State Register Publications (See R.I. Gen. Laws § 42-35-2.3(b)(1))
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K.
L.

Click the blue “Home” button.
To submit for review by the Department of State:
1. In the “Work Queue” tab, click on the
icon next to the title of the Rule
you just proposed to amend to Advance Workflow.
•

NOTE: This icon will only be available once all required
documents have been uploaded. If this icon is not available,
check to ensure you have uploaded all required documents.

2. On the following page, click the green “Advance” button.

M.

A notification will appear regarding the Office of Regulatory Reform’s review of
this filing. This applies to regular rulemaking only. If you have received ORR
approval, click “Yes.”

N.

Provide any necessary notes for Department of State staff in text fields for
“Outcome Note” and “Request Note.”
1.

If this Rule should become effective any later than the typical twenty (20)
days after filing (for Regular Proposed Rules) or the end of the public
comment period (for Direct Final Rules), please leave a note for the
Department of State in the “Request Note” field with the date you would like
this Rule to be effective.

O.

Click the blue “Submit” button at the bottom of the screen.

P.

Click “OK.” Your submission will be forwarded to the Department of State for
formatting review. Please note the Department of State may take up to five
(5) business days to review and advance or reject your filing.

1.4.4 Agency Head Signature Applied
A.

Once the Department of State completes the format review and advances the
workflow, an email notification will be sent to the designated Agency Head from
OneSpan requesting his or her e-signature. The message will state, “The APA
System has added you as a Signer to “XXX-RICR-XX-XX-XX Title of
Regulation.”

B.

Once the Agency Head clicks the blue “Go to Documents” button in the
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OneSpan notification email, he or she will be directed to the secure e-signature
site. The Agency Head must accept OneSpan’s consent and disclosures before
clicking the marked box to affix his or her digital signature.
C.

OneSpan will securely forward the digitally signed document to Department of
State staff for final processing. Once the document is fully signed and
processed, the Agency Head will receive email confirmation that the e-signing
process has been completed.
1.

1.5

The full e-signature procedures are laid out in the Guide for Agency
Heads, a copy of which is included at § 1.18, Appendix 9.

Repeal Procedures

1.5.1 Initial Data Entry and Documents Upload:
A.

Go to the RICR application login page at: https://rules.sos.ri.gov/login and
provide your login credentials.

B.

Make sure you have the “Current Rules” tab opened at the top of the screen.
Click on: “+ [Title Name]” to expand listing to show all available Chapters.

C.

Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D.

Click on “+ [Subchapter Name] to expand listing to show all available Parts.

E.

Click on the

F.

Click on the radio button to select “Proposed” for the Rulemaking Action.

G.

Click on the appropriate radio button for the “Rulemaking Process: *”. Either
select “Regular” or “Direct Final.”
1.

H.

icon next to the Part you wish to repeal.

NOTE: You will not be able to change the Rule Title when filing a
repeal.

If you wish to change or amend the rulemaking authority for this Part, select
either “R.I. General Laws” or "Alternative" as the selection in the drop-down
menu in “Rulemaking Authority: *” and enter the appropriate citation in the empty
text box and then click on the blue “Add >>” button. You may do this action as
many times as necessary to list all the applicable statutory authorities for your
repeal.
2.

When "R.I. General Laws" is selected, you only need to put in the actual
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numbers of the citation (ex. 42-35-1). The application will build the rest of
the citation for you.
3.

If you are citing a whole Chapter or Title in the R.I. General Laws, you
will want to select “Alternative” and write out the citation in full, as
selecting “R.I. General Laws” automatically adds a section symbol to all
entries.

I.

The summary of Proposed Rule will be pre-populated from the last rulemaking
action for this Part in the “Summary of Proposed Rule: *” field. You may alter this
text as needed.

J.

Provide a brief paragraph regarding the societal cost and benefits and cost of
compliance as prepared under R.I. Gen. Laws § 42-35-2.9. Include any citations
to scientific or statistical studies, reports, or analyses that served as a basis for
the Proposed Rule in the “Regulatory Analysis Summary and Supporting
Documentation: *” field by typing or by cutting and pasting from an existing
document.

K.

Enter the web address for the location on your website where the Notice of
Proposed Rulemaking and summary of the regulatory analysis are published
in the “Additional Information URL: *” field.

L.

Click the blue “Submit” button at the bottom of the page.

M.

Click the blue “Upload Documents” button.

N.

Select “Proposed Rule” from the “Document Type” drop-down menu.

O.

Click on “Choose File” or "Browse" button (depending on your browser) and
select the Word document containing the Proposed Rule with proposed
deletions using strikethrough formatting. For a repeal, all text should be struck
through.
1.

P.

NOTE: The Proposed Rule must be in .doc or .docx format, all other
document formats are not accepted.

Click the blue “Upload Document” button. You can continue to upload additional
documents, if you wish, by clicking "Upload More Documents."
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1.

NOTE: Additional Documents may be in one of the following formats:
•
•
•
•
•
•

.doc
.docx
.jpg
.jpeg
.xlsx, or
.pdf

Q.

Click the blue “Home” button.

R.

You can now review the Proposed Rule you uploaded under the "Text" tab on
the right side of the screen. You can use this feature to check your work.

S.

To submit for review by the Department of State: Under the “Work Queue” tab,

click on the
icon next to the title of the Rule you just proposed to repeal to
Advance the Workflow. On the next page, click the green “Advance” button.
T.

A notification will appear regarding the Office of Regulatory Reform’s review of
this filing. If you have received ORR approval, click “Yes.”

U.

Provide any necessary notes for Department of State staff in the text fields for
“Outcome Note” and “Request Note” (both optional).

V.

Click the blue “Submit” button at the bottom of the screen.

W.

Click “OK.” Your submission will be forwarded to the Department of State for
formatting review. Please note the Department of State may take up to five
(5) business days to review and advance or reject your filing.

1.5.2 Generation of the Notice of Proposed Rulemaking & Submission for
Promulgation
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A.

When your Rule is ready for you to generate your public notice of proposed
rulemaking, you will receive an AWS notification stating that this step is ready
for your action.

B.

At this time, you may upload additional documentation to be published with
this Rule. For more information on this process, see § 1.3.1(Q) above after
clicking the “Upload Document”
icon next to the Rule in your Work
Queue.

C.

You can also edit the details of your filing by clicking the “Edit”
icon from
your Work Queue. Several fields will no longer be editable at this time.

D.

Under the “Work Queue” tab at the top of the screen, expand
“Title>Chapter>Subchapter” to view your proposed repeal and click on the
icon to generate the Notice of Proposed Rulemaking and publish to the RICR
website.

E.

Click on the “Add>>” button under “Add a Public Comment Period.”

F.

The date of public notice will automatically be set to the date you generate the
notice. Click on the text box below “Date of End of Comment Period” and select a
valid date for the end of comment period. The application will automatically
calculate thirty (30) days from the date you generate the notice; however, you
may select a later date.

G.

Enter the name of the person designated to receive comments for this filing in the
“Full Name of Contact Person” text box.

H.

Enter the email address of that individual in the “Contact Person Email” text box.

I.

Enter the physical address where you would like the public to direct comments in
the “Contact Person Address” lines.

J.

Click on the appropriate radio button to indicate whether you will be accepting
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online submission of public comments under “Allow online public comments?”
1. If you select “Yes,” you will then need to indicate the dates during which
you will accept online comments through the RICR website. These dates
will automatically be pre-set to match the public comment period you
indicated in your notice however, you may elect to accept online comments
for any span between the dates of the public comment period.
•

NOTE: If you select “No,” you are still required to accept public
comments outside of the RICR.

K.

Click “OK.”

L.

If you will be having a Public Hearing, complete these additional steps:
1. NOTE: If you chose Direct Final rulemaking, this option is not available.
2. In the text box to the right of the first “Add >>” button, click on the dates for
the public comment period you just entered.
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3. Click on the “Add >>” button under the “Add a Public Hearing” section.
4. Click the text box under “Hearing date/time.” The application will
automatically calculate all available dates ten (10) days after the
beginning of your comment period and five (5) days before the end of
that comment period. Select a hearing date.

5. Click the dropdown box next to “Time:” and select a time and “AM” or
“PM.”
6. Enter text into the fields under “Hearing Location:” marked “Address Line
1”, “City” and “Zip code.”
7. Enter the phone number for the Special Assistance contact in the “Phone
Number for Special Assistance” text box. You are not required to enter an
extension, but you may.
8. Click “OK.”
M.

Click on the blue “Generate Notice” button at the bottom of the screen.
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N.

You will now be able to review the public notice you just created before
publishing your Rule. Review your notice. If you approve, click “Publish.” If
you wish to make changes, press “Cancel” to return to the previous screen.

O.

You will receive confirmation and a list of documents now available on the publicfacing RICR application.

P.

If you wish to amend the notice you just published, you can click “Amend Public
Notice” or click “Home” to return to your Work Queue.

Q.

When the notice is published, you will receive an AWS notification informing you
of the publication.

1.5.3 Post Public Comment Period Data Update and Document Upload

A.

Under the “Work Queue” tab at the top of the screen, expand the
Title>Chapter>Subchapter to view your proposed repeal. If you opted to accept
online public comments through the RICR during the public comment period,
click the
icon to review submitted online public comments. You must review
all online public comments before advancing the workflow to the next step. For
tips on reviewing online public comments, see § 1.7 of this Manual.
1.

NOTE: You may review online public comments at any time throughout
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the public comment period as well as once it concludes.
B.

Click on Upload Documents
the public comment period.

1.
C.

next to the proposed repeal that has completed

NOTE: If the Final Rule requires ORR approval, you must receive this
before completing the following step.

Click the drop-down menu under “Document Type” and select “Final Rule” from
the drop-down menu.
1.

NOTE: This document should be the same document you uploaded at
the proposed stage, showing all language struck through.

D.

Click on “Choose File” or “Browse” (depending on your browser) and select the
repeal Word document (the Rule showing all text struck-through) and click on
the blue “Upload Document” button (Required).

E.

Click the blue “Upload More Documents” button. “Final Rule” will now have a
green checkmark indicating it was uploaded successfully.
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F.

On the document upload page, under “Document Type,” select “Public
Comment” from the drop-down menu.

G.

Click “Choose File” or "Browse" (depending on your browser) and select the
document containing a copy of all comments received – or a statement that
no comments were received – and click on the blue “Upload Document”
button. You may upload additional Public Comment documents, if needed
(Required).
1. You do not need to upload copies of any comments received online
through the RICR website as the application will file those on your behalf.
•

NOTE: If you only received online comments for this filing, you may
upload a report of those comments by clicking the “Print” button on
the online comment review page and saving the pdf of the report
that is generated.

2. If you considered any comments received inappropriate for public display,
those comments should still be kept with the rulemaking file. If the comment
was received online through the RICR website, this process is complete. If
the comment was received by other means, you will need to maintain a copy
with your files for this rule.
H.

Click the blue “Upload More Documents” button and under “Document Type”
select “Concise Explanatory Statement” from the drop-down menu.
1. NOTE: The Public Comment document will now have a green
checkmark next to it under the Required Documents list.

I.

Click “Choose File” or “Browse” (depending on your browser) and select your
concise explanatory statement. Click “Upload Document.” A template for this
document can be found at § 1.15, Appendix 5 (Required).

J.

If necessary, click the blue “Upload More Documents” button and under
“Document Type” select the appropriate document type(s) from the drop-down
menu:
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1. Internal Agency Document (See R.I. Gen. Laws § 42-35-2.3(b)(9))
2. Public Hearing Documents (See R.I. Gen. Laws § 42-35-2.3(b)(5))
3. Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
4. Index of Studies/Reports (See R.I. Gen. Laws § 42-35-2.3(b)(3))
5. Petition seeking agency action for this Rule (See R.I. Gen. Laws § 42-352.3(B)(8))
6. Additional Documentation
7. State Register Publications (See R.I. Gen. Laws § 42-35-2.3(b)(1))
K.

Click the blue “Home” button

L.

To submit for review by the Department of State:
1. In the “Work Queue” tab, click on the
icon next to the title of the Rule
you just proposed to repeal to Advance the Workflow.
•

NOTE: This icon will only be available once all required documents
have been uploaded. If this icon is not available, check to ensure
you have uploaded all required documents.

2. On the following page, click the green “Advance” button.

M.

A notification will appear regarding the Office of Regulatory Reform’s review of
this filing. This applies only to regular rulemaking. If you have received ORR
approval, click “Yes.”

N.

Provide any necessary notes for Department of State staff in text fields for
“Outcome Note” and “Request Note.”
1. If this Rule should become effective any later than the typical twenty (20)
days after filing (for Regular Proposed Rules) or the end of the public
comment period (for Direct Final Rules), please leave a note for the
Department of State in the “Request Note” field with the date you would like
this Rule to be effective.

O.

Click the blue “Submit” button at the bottom of the screen.
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P.

Click “OK.” Your submission will be forwarded to the Department of State for
formatting review. Please note the Department of State may take up to five (5)
business days to review and advance or reject your filing.

1.5.4 Agency Head Signature Applied
A.

Once the Department of State completes the format review and advances the
workflow, an email notification will be sent to the designated Agency Head from
OneSpan requesting his or her e-signature. The message will state, “The APA
System has added you as a Signer to “XXX-RICR-XX-XX-XX Title of
Regulation”.

B.

Once the agency head clicks the blue “Go to Documents” button in the
OneSpan notification email, he or she will be directed to the secure e-signature
site. The agency head must accept OneSpan’s consent and disclosures before
clicking the marked box to affix his or her digital signature.

C.

OneSpan will securely forward the digitally signed document to Department of
State staff for final processing. Once the document is fully signed and processed,
the Agency Head will receive email confirmation that the e-signing process has
been completed.
1.

The full e-signature procedures are laid out in the Guide for Agency
Heads, a copy of which is included as § 1.18, Appendix 9.

1.6

Emergency Rule Procedures (§ 42-35-2.10)

A.

If an agency determines that an Emergency Rule (R.I. Gen. Law § 42-35-2.10) is
required due to a finding of imminent peril, they may file an Emergency Rule
without notice of proposed rulemaking, public comment, or a public hearing.
1.

The Rule will go into effect when it has been signed by the agency
head and the Governor or Governor’s designee.

2.

The Rule will remain in effect for a maximum of one hundred eighty (180)
days.
a.

3.

Emergency Rules are initially effective for one hundred twenty days
(120) but the agency may extend them for an additional sixty (60)
days.

An emergency amendment or repeal should contain mark-ups to
denote deletions and additions to the existing Rule and be
accompanied by a statement of the agency’s finding of imminent peril
which requires the Emergency Rule.
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4.

The actions and approvals steps for an Emergency Rule are as follows
[users who perform this step are noted in brackets]:
a.

Initial Data Entry and Documents Upload [Rules Coordinator,
Agency Head, or Filer]

b.

Rules Coordinator Notification of Emergency Rule [Rules
Coordinator]

c.

Submission for Promulgation [System]

d.

Agency Head Signature Applied [Agency Head]

e.

Governor Signature Applied [Governor’s Office]

f.

Final Rule and Signature acceptance by DOS [SOS Admin]

g.

Promulgation Finalization [System]
OPTIONAL

h.

Submission for Emergency Extension 1 [Rules Coordinator, Agency
Head, or Filer]

i.

DOS Final Revision for Emergency Extension 1 [SOS Admin]

j.

Finalization of Emergency Extension 1 [System]

1.6.1 Initial Data Entry and Documents Upload, Rules Coordinator Notification
and Submission for Promulgation
A.

Go the RICR application login page at: https://Rules.sos.ri.gov/login and
provide your login credentials.

B.

Click on: “+ [Title Name]” to expand listing to show all available Chapters.

C.

Click on “+ [Chapter Name]” to expand listing to show all available Subchapters.

D.

Click on “+ [Subchapter Name]” to expand listing to show all available Parts.

E.

Click on
next to the Part to start the Emergency Amendment process (for
an Emergency Adoption, click the blue “New Adoption” button next to the
appropriate Subchapter; for an Emergency Repeal, click on ).

F.

Click on the radio button to select “Emergency” for the Rulemaking Action.
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G.

Review the Rulemaking Authority already populated in the right-hand box and
click the “<<Remove” button if the information is not accurate.
1.

H.

NOTE: You will need to enter this information for an Emergency
Adoption, as it will not be pre-filled.

If further or new Rulemaking Authority information is required, select either “R.I.
General Laws” or "Alternative" as the selection in the drop-down menu in
“Rulemaking Authority: *” and enter the appropriate citation in the empty text box
and then click on the blue “Add >>” button. You may do this action as many times
as necessary to list all the applicable statutory authorities for your filing.
1.

When "R.I. General Laws" is selected, you only need to put in the actual
numbers of the citation with appropriate hyphens (ex. 42-35-1). The
application will build the rest of the citation for you.

2.

If you are citing a whole Chapter or Title in the R.I. General Laws, you
will want to select “Alternative” and write out the citation in full, as
selecting “R.I. General Laws” automatically adds a section symbol to all
entries.

I.

Remove the text from the previous rulemaking completed for this Part, if
applicable, and, in plain language, provide a statement of the subject matter of
the Proposed Rule, including the terms or substance of the intended action, or a
description of the issues involved. Include a summary of any non-technical
changes between current and Proposed Regulations in the “Summary of
Proposed Rule: *” field by typing or by cutting and pasting from an existing
document.

J.

Provide your finding for imminent peril to the public health, safety, or welfare or
the loss of federal funding in the “Brief Statement of Reason for Finding Imminent
Peril: *” field by typing or by cutting and pasting from an existing document.
Enter the URL address for the Emergency Rule and reasons for finding of
imminent peril published on your agency website in the “Additional Information
URL: *” field.

K.

L.

Click the blue “Submit” button at the bottom of the page.

M.

Click the blue “Upload Documents” button.

N.

Select “Proposed Rule” from the “Document Type” drop-down menu.
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O.

Click on “Choose File” or "Browse" button (depending on your browser) and
select the Word document containing the Proposed Rule with new
language clearly marked using underline formatting and proposed deletions
using strikethrough formatting.
1.

NOTE: Emergency Adoptions must have all text underlined and
Emergency Repeals must have all text struck through.

2.

NOTE: The Proposed Rule must be in .doc or .docx format. All
other document formats are not accepted.

P.

Click the blue “Home” button or click “Upload More Documents” to upload
additional documentation.

Q.

Under the “Work Queue” tab at the top of the screen, the
Title>Chapter>Subchapter will be expanded allowing you to view your
Emergency Rule and click on the
icon to advance the workflow.
1.

Then, click “Advance” under the Workflow tab.

2.

A notification will appear regarding the ORR’s review of this filing. If you
have received ORR approval, click “Yes.”

3.

Click the blue “Submit” button at the bottom of the screen.

4.

Click “OK.”
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a.

R.

NOTE: this advancement sends a notification to the Rules
Coordinator that an Emergency Rule has been entered. At this
point, the Rule has NOT been sent to the agency head for
signature. This is to ensure an agency is afforded the opportunity
to complete any internal procedures prior to obtaining the hgency
Head’s e-signature.

Again, when logged in as the Rules Coordinator, Repeat Step Q above.

1.6.2 Agency Head & Governor Signatures Applied
A.

Once the workflow has been advanced, an email notification will be sent to the
designated Agency Head from OneSpan requesting his or her e-signature. The
message will state, “The APA System has added you as a Signer to “XXXRICR-XX-XX-XX Title of Regulation”.

B.

Once the Agency Head clicks the blue “Go to Documents” button in the
OneSpan notification email, he or she will be directed to the secure e-signature
site. The agency head must accept OneSpan’s consent and disclosures before
clicking the marked box to affix his or her digital signature.

C.

OneSpan will securely forward the digitally signed document to the Governor’s
Office for his or her electronic signature. The Governor or Governor’s designee
will indicate his or her name and click the indicated signature box to affix his or
her digital signature.

D.

OneSpan will securely forward the digitally signed document to Department of
State staff for final processing. Once the document is fully signed and processed,
the Agency Head and Governor’s Office will receive email confirmation that the
e-signing process has been completed. The agency’s Rules Coordinator
will receive notification that the filing has been completed.
1.

The full e-signature procedures are laid out in the Guide for Agency
Heads, a copy of which is included as § 1.18, Appendix 9.

1.6.3 Submission for Emergency Extension
A.

At any time during the effective period of an Emergency Rule, you may
file for one (1) sixty (60) day extension.

B.

In the “Current Rules” tab, scroll down to the expandable
Title>Chapter>Subchapter listing beneath the heading “Active Emergency
Rules.”

C.

Click the

icon next to the Emergency Rule you wish to renew.
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D.

Click the green Advance button.

E.

(Optional) Enter any information in the Outcome Notes or Request Notes fields
you wish to keep with the rulemaking record.

F.

Click the blue “Submit” button on the bottom of the screen. The extension
request will be submitted to the Department of State and the effective date of
this emergency filing will be extended to sixty (60) days from the original
ineffective date.

1.7

Reviewing Public Comments

A.

If you opted to allow members of the public to submit comments online directly
through the RICR website, you must complete a review process for each
comment submitted before you can advance a Rule for finalization.

B.

Under the “Work Queue” tab at the top of the screen, expand the
Title>Chapter>Subchapter to view the proposed adoption, repeal, or
amendment.
Click the
icon to review submitted online public comments.
1. NOTE: You may review comments during the public comment period
as well as after it has completed. You must review all online
comments to advance the workflow.

C.

All comments submitted online through the RICR website will be listed in the
“Pending” tab for those not yet reviewed and in the “Reviewed” tab for those
already reviewed.

1.

When you are ready to forward your Rule to the Department of State for
final review, make sure there are no comments remaining in the
“Pending” tab.
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D.

For each comment received online, click anywhere on the underlined text
of that comment to expand the details. Click the “Review” button.

E.

Determine whether the agency considers the comment appropriate for public
display. If yes, click the radio button for “Yes” next to “Enable public comment
display?” If no, click the radio button for “No.”

F.

1.

If you indicate that the comment is not appropriate for public display, you
must provide the reason that comment should not be displayed. To give a
reason other than the ones provided, select “Other” and enter text in the
box below the drop-down menu.

2.

All comments are marked
or
. You
may re-review online comments in the “Reviewed” tab at any time
before advancing the Rule to the next step in the workflow.

If you wish, you may enter internal review notes – which will not be visible to the
public – and/or public review notes – which are optionally displayed to the public.
1.

NOTE: To prevent your public review notes from being shown on the
RICR website, you will need to check the checkbox

G.

Click the blue “OK” button.

H.

To print a report of the online comments for dissemination to staff, click the
blue “Print” button at the top of the page. This report is produced ondemand. You may perform this action as many times as you wish.

1.8

Technical Revision Procedures (§ 42-35-4(b))

A.

A minor non-substantive change can be made through a written request (via
email) from an agency’s Rules Coordinator or initiated by Administrative Records
Office staff. If initiated by Administrative Records Office staff, the agency Rules
Coordinator will be notified of the change. The scope of these corrections can run
from grammar, punctuation, and cross-reference corrections, to a name change
of the agency.

B.

If you would like the Administrative Records Office to complete a
Technical Revision on a Rule, please contact us at
RulesRegs@sos.ri.gov.
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1.9

Termination Procedures

A.

You may choose to terminate a filing at any time when the filing is in your work
queue by clicking the
icon next to the name of that Part in your work queue
and indicating a reason for termination.

1.

NOTE: If you terminate a filing prior to publishing any documents publicly, a
notification will not be sent to the public for this termination. Additionally,
the reason you choose for the termination will not be made public,
regardless of when you terminate.

B.

If the Part you wish to terminate is not in your work queue but is under review by
the Department of State, you may recall that Part to your work queue by clicking
“Reset” next to the name of the Part in the “Under Review” tab. You may then
terminate the Part by following the instructions above.

C.

When terminating a Part which was filed as an adoption but did not complete the
rulemaking process, you will not be able to use that Part number again in the
future if the filing was terminated after the public comment period has
begun (Proposed Regular, Direct Final, and Advance Notice filings).

1.10 Requirements under the APA
1.10.1 Rulemaking Agenda Procedures (§ 42-35-5.1)
B.

The rulemaking agenda is a document listing all proposed rulemaking currently in
effect for your agency. The rulemaking agenda must be updated in real time and
include the following information for all Rules proposed by your agency:
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C.

1.

The subject matter of the Proposed Rule;

2.

Notices related to the Proposed Rule;

3.

How comments on the Proposed Rule may be submitted;

4.

The time within which comments may be submitted;

5.

Where comments may be inspected;

6.

Requests for a public hearing;

7.

Appropriate information concerning a public hearing, if any; and

8.

The timetable for action on the Proposed Rule.

The law requires that the rulemaking agenda be published both on the agency’s
website and the Department of State’s website.
The rulemaking agendas will be published in the RICR application under the
Agency Summary section.

1.10.2 Guidance Document Index Procedures (R.I. Gen. Laws § 42-35-2.12)
A.

Agency Rules Coordinators must submit a Guidance Document Index to the
Department of State annually. This does not preclude an agency from updating
its Index throughout the year as new documents are published. The index must
also be published on the agency’s website.

B.

The APA defines a Guidance Document as “a record of general applicability
developed by an agency which lacks the force of law but states the agency's
current approach to, or interpretation of, law or describes how and when the
agency will exercise discretionary functions.” (R.I. Gen. Laws § 42-35-1(9))

C.

The Guidance Document Index should contain the title, publication date, and
URL of any Guidance Documents published by the agency.

D.

Submission of Guidance Document Index:
1.

Go the RICR application login page at: https://Rules.sos.ri.gov/login
and provide your login credentials.

2.

Click on the “Manage” drop-down menu at the top of the screen and
select "Guidance Document Index."
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3.

You will then be navigated to the “Guidance Document Index Listing” page
where you can see your past guidance document indices.

4.

Click on "New" at the upper right-hand side of the screen.

5.

Any guidance documents you previously submitted will appear in
the guidance document list. You can now add or remove guidance
documents to create a new Index.

6.

a.

To remove documents from the list, highlight the document name
and click the blue “Remove” button.

b.

To add documents to the list, enter the effective date of your
guidance document, the title of your guidance document, and the
URL where the guidance document is published on your website
(NOTE: if you do not include “http:// or https:// in your document
link, no hyperlink will be created). Click the “Add” button. Repeat
as needed.

When all current guidance documents are entered, click the "Generate
Guidance Document Index" button at the bottom of the page.

Nellie M Gorbea – Secretary of State

71 | P a g e

E.

Please note if your agency does not have any guidance documents, you are still
required to submit a guidance document Index annually. To do so, follow the
steps above. Do not enter any guidance document information. Click “Generate
Guidance Document Index.” A blank index will be created stating that your
agency does not have any guidance documents.

F.

Once you generate your Index, you can download a copy to manually post on
your website or link directly to the Index on the RICR.

1.10.3 Declaratory Orders and Declaratory Order Index Procedures (R.I. Gen. Laws
§ 42-35-8)
A.

If an agency issues a Declaratory Order, the order must contain the names of
all parties to the proceeding, its factual basis, and the reasons for the agency's
conclusion.

B.

The Declaratory Order becomes effective once filed electronically with the
Department of State.

C.

An agency must publish a current Index of all effective Declaratory Orders.

D.

When you file a Declaratory Order in the RICR application, the Declaratory
Order Index is automatically updated.

E.

Filing of Declaratory Order in the RICR application:
1.

Go the RICR application login page at: https://Rules.sos.ri.gov/login
and provide your login credentials.

2.

Click on the Manage drop-down menu at the top of the screen and select
"Declaratory Order."

3.

You will be navigated to the “Declaratory Orders” page where you can see
your agency’s current Declaratory Orders as well as those that are pending
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approval.
4.

Click on "New" at the upper right-hand side of the screen.

5.

Enter the title of the Declaratory Order in the "Document Title" text field.

6.

Click on "Choose File" or "Browse" depending on your browser and select
the Declaratory Order for upload and click "Upload Document."

a.

NOTE: Declaratory Orders must be uploaded in .pdf format only.

7.

The document you uploaded will now be available for review under the
heading “Declaratory Orders Awaiting Approval.” Confirm you have
uploaded the correct document. If you have, click “Approve” to forward the
Declaratory Order to Department of State staff for filing.

8.

Once the Department of State processes the document, it will be added
automatically to the agency’s Declaratory Order Index.

9.

You can also delete Declaratory Orders that have already been
approved by checking the box in the ‘Delete’ column on the
“Declaratory Orders” page and clicking the Delete button.

1.10.4 Advance Notice of Proposed Rulemaking Procedures (ANPRM) (R.I.
Gen. Laws § 42-35- 2.5)
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B.

An Advance Notice of Proposed Rulemaking is not a required step in the
rulemaking process; however, it is a useful tool if an agency wishes to gather
information and solicit comments and recommendations from the public prior to
formally posting a Proposed Rule.

C.

The agency must publish a copy of the ANPRM on its website.

D.

The meeting must be open to the public and is subject to the Open Meetings Act,
R.I. Gen. Laws Chapter 42-46.

E.

Procedures for filing of an ANPRM in the RICR application:
1.

Go the RICR application login page at: https://Rules.sos.ri.gov/login
and provide your login credentials.

2.

Click on: “+ [Title Name]” to expand listing to show all available Chapters.

3.

Click on “+ [Chapter Name]” to expand listing to show all available
Subchapters.

4.

Click on “+ [Subchapter Name]” to expand listing to show all available
Parts.

5.

Click on

next to the Subchapter to post an APRN for a

potential adoption or
or
ANPRM for an existing Part.

next to an existing Part to start the

6.

Click on the radio button to select “Advance Notice” for the Rulemaking
Action.

7.

For a possible adoption: assign a new Part number in the Rule Identifier:*
text box.

8.

Enter the title of the potential Part that is the subject of the ANPRM in the
Regulation Title:* text box.
a.

9.

NOTE: If you are creating an advance notice filing for a potential
repeal, you will not be able to change the Regulation Title.

Enter the rulemaking authority citation(s) or review the Rulemaking
Authority already populated in the right-hand box and click the
“<<Remove” button if the information is not accurate. If further or new
Rulemaking Authority information is required, select either “R.I. General
Laws” or "Alternative" in the drop-down menu next to “Rulemaking
Authority: *” and enter the appropriate citation in the empty text box. Click

Nellie M Gorbea – Secretary of State

74 | P a g e

on the blue “Add >>” button. You may do this as many times as necessary
to list all of the applicable rulemaking authorities for your adoption,
amendment, or repeal.
a.

When "R.I. General Laws" is selected, you only need to put in the
actual numbers of the citation with appropriate hyphens (ex. 4235-1). The application will build the rest of the citation for you.

b.

If you are citing a whole Chapter or Title in the R.I. General Laws,
you will want to select “Alternative” and write out the citation in
full, as selecting “R.I. General Laws” automatically adds a section
symbol to all entries.

10.

Provide the ‘Advance Notice Details’ indicating where, when, and
how persons may comment before the rulemaking process begins.

11.

Enter the URL address for the ANPRM published on your agency website
in the “Additional Information URL: *” field.

12.

Click the blue “Submit” button at the bottom of the page.

13.

If you are attaching a Proposed Rule: click “Upload Documents.”
a.

Select “Proposed Rule” from the “Document Type” drop-down
menu.

b.

Click on “Choose File” or "Browse" depending on your browser and
select the document in .doc or .docx format containing the
Proposed Rule with the proposed language clearly marked using
underline formatting for proposed insertions and strikethrough
formatting for proposed deletions.
•

NOTE: Proposed Adoptions should have all text
underlined.

c.

Click on the blue “Upload Document” button.

d.

You may then upload additional documents by clicking “Upload More
Documents” and then choosing an additional documentation type
from the drop-down menu.
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e.

If you do not want to upload any additional documents, you can
click “Home” to return to the Work Queue.

f.

Click on the
icon next to the title of your ANPRM to advance
the workflow. Click the green Advance button to publish your
ANPRM and related Rule document.

14.

If you do not want to upload a document, click on

15.

Enter any outcome or request notes (optional), then click “Submit.”
Click “Ok.”

16.

Under the “Work Queue” tab, click the
icon next to the name of the
filing you just created to generate the Advance Notice of Proposed
Rulemaking and publish to the RICR website.

17.

Click on the “Add>>” button under “Add a Public Comment Period.”

18.

The date of public notice will automatically be set to the date you generate
the notice. Click on the text box below “Date of End of Comment Period”
and select a valid date for the end of comment period. There are no
restrictions on the length of the comment period for an Advance Notice.

19.

Enter the name of the person designated to receive comments for this
filing in the “Full Name of Contact Person” text box.

20.

Enter the email address of that individual in the “Contact Person Email”
text box.

21.

Enter the physical address where you would like the public to direct
comments.

22.

Click on the appropriate radio button to indicate whether you will be
accepting online submission of public comments under “Allow online
public comments?
a.

.

If you select “Yes,” you will then indicate the dates during which you
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will accept online comments through the RICR website. These
dates will automatically be pre-set to match the public comment
period you indicated in your notice; however, you can choose to
accept online comments between any dates within your established
public comment period.
b.

If you select “No,” you will still need to accept public comments
outside of the RICR website.

23.

Click “OK.”

24.

If you will be having a public hearing, complete these additional steps:
a.

In the text box to the right of the first “Add >>” button, click on the
dates for the public comment period you just entered.

b.

Click on the “Add >>” button under the “Add a Public Hearing”
section.

c.

Click the text box under “Hearing date/time.” The application will
automatically calculate all available dates within the public
comment period you selected. Select a hearing date.

d.

Click the dropdown box next to “Time:” and select a time and “AM”
or “PM.”

e.

Enter text into the fields under “Hearing Location:” marked “Address
Line 1”, “City” and “Zip code.”
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Enter the phone number for the Special Assistance contact in the
“Phone Number for Special Assistance” text box. You are not
required to enter an extension, but you may.

g.

Click “OK.”

25.

Click on the blue “Generate Notice” button at the bottom of the screen.

26.

You will now be able to review the Advance Notice you just created before
publishing it. If you approve, click “Publish.” If you wish to make changes,
press “Cancel” to return to the previous screen.
You will receive confirmation and a list of documents now available on the
public-facing RICR application.

27.
F.

f.

At any time during or after the public comment period you set for your Advance
Notice, you may choose to continue on to the full rulemaking process. To do this,
click the
icon next to the name of your ANPRM in the “Work Queue” tab. You
can then follow the steps outlined in the sections above.

1.10.5 Petition for Promulgation of Rules (§ 42-35-6)
A.

Each agency must promulgate a Rule providing an explanation of the
procedure for an individual to petition the agency to promulgate a Rule.

B.

The Rule must contain the following information:

C.

1.

The form of the petition;

2.

The procedure for submitting the petition to the agency; and

3.

The procedure the agency must follow in considering and acting on
the petition.

The Department of State has provided a sample Petition for Promulgation of
Rules Regulation (Appendix 6: Sample Petition for Promulgation of Rules
Regulation). This sample is intended as a tool for agencies’ use in promulgating
its Rule as required by the APA. Agencies are not required to use the sample
when promulgating their Rule regarding Petition for Promulgation of Rules.

1.10.6 Petition for Declaratory Order (R.I. Gen. Laws § 42-35-8)
A.

Each agency must promulgate a Rule providing an explanation of the
procedure for an individual to petition the agency for a Declaratory Order.
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B.

C.

The Rule must contain the following information:
1.

The form of the petition;

2.

The procedure for submitting the petition to the agency; and

3.

The procedure the agency must following in considering and acting on
of the petition.

The Department of State has provided a sample Petition for Declaratory Order
Regulation (Appendix 7: Sample Petition for Declaratory Order Regulation). This
sample is intended as a tool for agencies’ use in promulgating its Rule as
required by the APA. Agencies are not required to use the sample when
promulgating their Petition for Promulgation of Rules.

1.10.7 Conduct of Public Hearings (§ 42-35-2)
A.

Each agency must promulgate a Rule prescribing the way public hearings
are conducted.

B.

The Department of State has provided a sample Conduct of Public Hearings
Regulation (Appendix 8: Conduct of Public Hearings Regulation). This sample
is intended as a tool for agencies’ use in promulgating its Rule as required by
the APA. Agencies are not required to use the sample when promulgating their
Conduct of Public Hearings Regulation.
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1.11 Appendix 1: Examples of Styles in the RICR Template
REPLACE THIS TEXT WITH THE FULL RICR NUMBER (XX-RICR-XX-XX-XX)

REPLACE THIS TEXT WITH THE RICR TITLE NUMBER – NAME
(AGENCY NAME)
REPLACE THIS TEXT WITH THE RICR CHAPTER NUMBER – NAME (FUNCTION)
REPLACE THIS TEXT WITH THE RICR SUBCHAPTER NUMBER - NAME (TOPIC)

REPLACE THIS TEXT WITH THE RICR PART NUMBER – NAME (REGULATION)
[The suggested numbering and format below will help you create your new
Regulation. Replace each ‘x’ with the appropriate number for both Rule numbers and
Statute citations - Delete this paragraph and any other extraneous text below.]

x.1 Replace This Text with a Heading (Title 1)
x.1.1 Replace This Text with a Subheading (Title 2 – this heading level is
optional)
A.

Replace this text with Paragraph 1 – use the following subsections as
appropriate
1.

Replace this text with Paragraph 2 (subsection of Paragraph 1)
a.

Replace this text with Paragraph 3 (subsection of Paragraph 2)
(1)

Replace this text with Paragraph 4 (subsection of Paragraph
3)
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1.12 Appendix 2: Regular Rulemaking Process

Agency decides to
commence rulemaking.

Agency completes
regulatory preparation
and analysis and
submits to OMB for
review.

Agency begins
Advance Notice of
Proposed
Rulemaking
(optional): R.I. Gen.
Laws § 42-35-2.5.

Public Comment
period begins
(minimum of thirty
(30) days)

Agency gives Notice of
Proposed Rulemaking

Agency submits
Proposed Rule to
Dept. of State for
format review.

Agency holds public
hearing (optional) at
least ten (10) days
after notice and at
least five (5) days
before end of
comment period.

Rule goes into effect
twenty (20) days after
filing with the Dept. of
State
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Public comment period
ends

Agency submits Final
Rule to Dept. of State
for review and files
Rule.

Agency finalizes Rule

Submit finalized Rule
to OMB
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1.13 Appendix 3: Direct Final Rulemaking Process

Agency decides to
commence
rulemaking on a
Rule it deems
non- controversial

Completes
regulatory
preparation and
submits to OMB
for review

Rule becomes
effective as of the
end of public
comment period

Begin Advance
Notice of Proposed
Rulemaking
(optional) per R.I.
Gen. Laws § 42-352.5

No objection
received:
Agency files Final
Rule and
rulemaking
documents in the
RICR Filing
Application

Objection received:
Agency must start rulemaking process again using
the steps outlined in Appendix 2

Notice of Proposed
Rulemaking of
Direct Final
Adoption,
Amendment or
Repeal

Public comment
period ends

1.14 Appendix 4: Emergency Rulemaking Process
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1.15 Appendix 5: Concise Explanatory Statement Template
CONCISE EXPLANATORY STATEMENT

In accordance with the Administrative Procedures Act, R.I. Gen. Laws § 42-35-2.6,
the following is a concise explanatory statement:
AGENCY:
DIVISION: (If any)
RULE IDENTIFIER: (RICR Citation)
RULE TITLE: Provide the full title of the Rule.
REASON FOR RULEMAKING: Provide a brief description of the reason for the
adoption, amendment or repeal of the Rule.
ANY FINDING REQUIRED BY LAW AS A PREREQUISITE TO THE
EFFECTIVENESS OF THE RULE: (if any)
TESTIMONY AND COMMENTS: Provide the reasons for not accepting arguments
made in testimony and comments.
CHANGE TO TEXT OF THE RULE: Identify any changes between the text of the Rule
as proposed and the text of the Final Rule and explain why these changes were made
to the final text. Note that an agency may not file a Rule that differs from the Rule
proposed in the Notice of Proposed Rulemaking unless the Final Rule is consistent
with, and a logical outgrowth of, the Rule proposed in the Notice.
REGULATORY ANALYSIS: Provide the text of the regulatory analysis prepared under
R.I. Gen. Laws § 42-35-2.9.
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1.16 Appendix 6: Sample Petition for Promulgation of Rules
Regulation
This sample is an example only and not intended to be prescriptive of an agency’s
requirements under the Administrative Procedures Act. Agencies may choose to
disregard this sample.
XXX-RICR-XX-XX-XX

RICR TITLE NUMBER – NAME (AGENCY NAME)
RICR CHAPTER NUMBER – NAME
(FUNCTION) RICR SUBCHAPTER NUMBER –
NAME (TOPIC)
THE RICR PART NUMBER – Petition for Promulgation of Rules

x.1

Purpose
The purpose of this Regulation is to prescribe the form of a Petition for
Promulgation of Rules pursuant to R.I. Gen. Laws § 42-35-6 and the procedure
for its submission, consideration, and disposition.

x.2

Authority
This Regulation is promulgated pursuant to the authority granted in R.I.
Gen. Laws § 42-35-6.

x.3

Definitions

A.

The following definitions shall apply to this Regulation:
1.

"Department" means <insert agency>.

2.

"Petition" means a request for the Promulgation of a Rule.

3.

"Petitioner" means a person requesting the promulgation of a Rule.

4.

"Promulgate", with respect to a Rule, means the process of writing a new
Rule, or amending or repealing an existing Rule.

5.

"Rule" means the whole or a part of an agency statement of general
applicability that implements, interprets, or prescribes law or policy or the
organization, procedure, or practice requirements of an agency and has
the force of law. The term includes the amendment or repeal of an existing
Rule. The term is used interchangeably with the term "Regulation." The
term does not include the exceptions listed in R.I. Gen. Laws §§ 42-35-
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1(19)(i) through (vi).
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x.4

Request for the Promulgation of a Rule

A.

A request to Promulgate a Rule must be in writing and include the following
information:

B.

1.

The name and address of the Petitioner;

2.

A plain statement identifying the Rule or proposed new Rule at issue;

3.

A detailed statement of all facts relied upon by the Petitioner;

4.

A plain statement requesting the Promulgation of a Rule, and further
indicating whether Petitioner seeks a new Rule or the amendment or
repeal of an existing Rule.
a.

In the case of a request for the repeal of an existing Rule, the
Petitioner shall identify the Rule by title and/or RICR citation.

b.

In the case of a request for an amendment to an existing Rule, the
Petitioner must identify with specificity any proposed additions,
deletions, or other amendments. New proposed language must be
clearly marked using underline formatting for proposed insertions,
and strikethrough formatting for proposed deletions.

A request for the Promulgation of a Rule must be submitted to:
<Insert agency contact information.>

x.5

Consideration and Disposition of Request for the Promulgation
of a Rule

A.

The Department shall promptly consider and respond to the request for the
Promulgation of a Rule as provided in R.I. Gen. Laws § 42-35-6.

B.

The Department may, at its discretion and within the thirty (30) day period
prescribed by Statute:
1.

Hold a hearing for further consideration and discussion on the Petition; or

2.

Request further information or documents from the Petitioner necessary
for the full evaluation of his or her Petition.
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1.17 Appendix 7: Sample Petition for Declaratory Order Regulation
This sample is an example only and not intended to be prescriptive of an agency’s
requirements under the Administrative Procedures Act. Agencies may choose to
disregard this sample.
XXX-RICR-XX-XX-XX

RICR TITLE NUMBER – NAME (AGENCY NAME)
RICR CHAPTER NUMBER – NAME (FUNCTION)
RICR SUBCHAPTER NUMBER – NAME (TOPIC)
RICR PART NUMBER – Declaratory Order Petitions

x.1

Purpose
This Regulation states the requirements for submitting a request for Declaratory
Order under R.I. Gen. Laws § 42-35-8(b), and the procedure for its consideration
and prompt disposition.

x.2

Authority
This Regulation is promulgated pursuant to the authority granted in R.I.
Gen. Laws § 42-35-8.

x.3

Definitions

A.

The following definitions shall apply to this Regulation:
1.

"Declaratory Order" means an order issued by the Department that:
a.

Interprets or applies a Statute administered by the Department;

b.

Clarifies whether a Rule, guidance document, or order issued by
the Department applies to a Petitioner; or

c.

Clarifies how a Rule, guidance document, or order issued by
the Department applies to a Petitioner.

2.

"Department" means <insert agency>.

3.

"Petition" means a request for a Declaratory Order.

4.

"Petitioner" means a person requesting a Declaratory Order.
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x.4

Request for Declaratory Order: Form and Submission

A.

A request for Declaratory Order must be in writing and include the following
information:
1.

The name and address of the Petitioner;

2.

A plain statement identifying the Statute, Rule, Guidance Document,
or Order at issue;

3.

A detailed statement of all facts relied upon by the Petitioner;

4.

A copy of any and all documents relied upon by Petitioner that are not
otherwise accessible to the Department; and

5.

A plain statement requesting a Declaratory Order, and further indicating
whether Petitioner seeks:
a.

An interpretation or application of a Statute administered by
the Department;

b.

Clarification as to whether a Rule, Guidance Document, or
Order issued by the Department applies to Petitioner; and/or

c.

Clarification as to how a Rule, Guidance Document, or Order
issued by the Department applies to Petitioner.

B.

A request for a Declaratory Order must be submitted to: <insert agency contact
information.>

x.5

Consideration and Disposition of Request for Declaratory Order

A.

The Department shall promptly consider and respond to the request for
Declaratory Order as provided in R.I. Gen. Laws § 42-35-8(c).
1.

B.

C.

Should the Department schedule the matter for further consideration, the
Department shall notify Petitioner in writing of the anticipated date on
which the Department will grant or deny the request for Declaratory Order.

The agency may, at its discretion:
1.

Hold a hearing for further consideration and discussion on the Petition; or

2.

Request further information or documents from the Petitioner necessary
for the full evaluation of his or her petition.

A Petitioner may appeal the Department's final disposition of the request for
Declaratory Order as provided in R.I. Gen. Laws § 42-35-15.
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1.18 Appendix 8: Sample Conduct of Public Hearings Regulation
This sample is an example only and not intended to be prescriptive of an agency’s
requirements under the Administrative Procedures Act. Agencies may choose to
disregard this sample.
XXX-RICR-XX-XX-XX

RICR TITLE NUMBER – NAME (AGENCY NAME)
RICR CHAPTER NUMBER – NAME
(FUNCTION) RICR SUBCHAPTER NUMBER –
NAME (TOPIC)
RICR PART NUMBER – Conduct of Public Hearings

x.1

Purpose
To establish a defined set of procedures for the <insert agency> for the conduct
of Public Hearings regarding Proposed Rulemaking.

x.2

Authority
This Regulation is promulgated pursuant to the authority granted in R.I. Gen.
Laws § 42-35-2(a)(4).

x.3

Definitions

A.

For the Purpose of this Regulation:
1.

"Department" means <insert agency>.

2.

“Member of the public” means any individual, firm, business, corporation,
association, partnership or other group.

3.

“Presiding department official” means the <insert agency> employee
conducting the Public Hearing.

4.

"Public hearing" means the convening of Members of the Public and
agency personnel for the purpose of obtaining public comment on a
Proposed Rulemaking.

5.

“Proposed rulemaking” means a proposed new Rule, proposed
amendment to a Rule or proposed repeal of a Rule as noticed pursuant
to R.I. Gen. Laws § 42-35-2.7.
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x.4

Procedure for Conduct of Public Hearings

A.

Convening of Public Hearing

B.

C.

1.

Public Hearings may be held at the election of the agency or as required
pursuant to R.I. Gen. Laws § 42-35-2.8(c).

2.

Notice of Public Hearings shall be issued in accordance with the
provisions of R.I. Gen. Laws §§ 42-35-2.8 and 42-46-6, when applicable.

3.

The Public Hearing shall be held at a time and place designated by the
Department.

Transcription
1.

The Public Hearing shall be transcribed by a stenographer or audio
recorded.

2.

For Public Hearings, any official transcript, recording, or memorandum
summarizing presentations prepared by an agency official shall be made
part of the rulemaking record in accordance with R.I. Gen. Laws § 42-352.3(b)(5).

Testimony
1.

2.

Oral Testimony
a.

Members of the public may make oral testimony during the
meeting.

b.

Members of the public who wish to make oral testimony during the
meeting must put their name on the speaker list.

c.

Members of the public will be called to testify in the order which
their names appear on the speaker list.

Written Testimony
a.

D.

Written testimony must be submitted via e-mail, fax, hand delivery
or regular mail to: <insert contact information>.

Disruptive Conduct
1.

Members of the Public attending the Public Hearing shall not cause
disruptions, including but not limited to: screaming, loud noises, and
disorderly gesticulations, which interrupt or distract from the testimony of
other Members of the Public or from the ability of the Presiding
Department Official to conduct the Public Hearing.
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1.19 Appendix 9: Signing and Filing Born-Digital Rules – A Guide for
Agency Heads
Overview of the Rhode Island Code of Regulations and E-Signatures
A.

The Rhode Island Code of Regulations (RICR) is a uniform, online code of all
Regulations promulgated by state agencies, boards and commissions
according to the state’s Administrative Procedures Act (APA), R.I. Gen. Laws
Chapter 42-35. Rules filed in the RICR are assigned a unique identifying
number and must adhere to formatting standards set by the Department of
State.

B.

Any Rule published in the RICR after August 14, 2018, requires a digital
signature by the Head of the Agency promulgating that Rule. This includes
regular, direct final, and emergency adoptions, amendments and repeals. This
procedure does not apply to Technical Revisions which are processed entirely by
Department of State staff.
1.

C.

NOTE: The APA defines “Agency Head” as “the individual in whom, or
one or more members of the body of individuals in which, the ultimate
legal authority of an agency is vested” (R.I. Gen. Laws 42-35-1).

The Department of State contracts with OneSpan, a third-party e-signature
vendor, to apply digital signatures to Rules published in the RICR. A secure copy
of each signed Rule is then immediately archived by Department of State staff in
a trusted digital repository where it undergoes constant surveillance to ensure
the lasting integrity of these important public records.

Getting Started
A.

The filing application allows, but does not require, an Agency Head to perform a
number of functions to move a Proposed Rule through the rulemaking process.
Keep in mind the Agency Head is never required to log in to the RICR
application.

B.

When you are first assigned the role of Agency Head in the RICR application,
you will receive an email from rulesregs@sos.ri.gov asking you to agree to
receive notifications through the RICR. You need only accept this request once.

C.

If you would like a member of your staff to receive duplicate copies of
notifications sent to you through the RICR, please follow the procedures below.
1.

Log in to the RICR filing application using your unique credentials.

2.

Select “Notifications” under the “Manage” menu at the top of the screen.

3.

A list of all users with login credentials for your agency will appear. Click
the “Subscribe” button under the “Action” column next to any user you
wish to receive the same notifications you do. That user will then
receive an email requesting acceptance of this subscription.

4.

Once a user is subscribed, the button next to that user’s name will read
“Unsubscribe.” You may follow the same steps to unsubscribe him or her
at any time.
a.

NOTE: Once you click “Subscribe,” until the user confirms that they
would like to be subscribed, the button will read “Pending
Confirmation.”

Applying Your Signature
A.

When a member of your staff submits a Final Rule for your signature, you will
receive an email notification directly from OneSpan. The email will include a link
to the documents requiring your signature.
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B.

Click the button labeled “Go to Documents.” Your default browser will open you
will be taken to a Consent and Disclosure agreement from OneSpan.

C.

Click the checkbox next to “I have read and agree to the terms of the eSign
Disclosure Document.” Then click “Accept”

D.

OneSpan will load the Rule awaiting your approval. The full text of the Final
Rule awaiting your signature will appear. Scroll to the last page of the document
to find the signature page or click the purple button reading “Next.” All fields will
be blank and a purple box will be placed in the area you must click to apply your
digital signature. You must then click “Confirm” to complete the process.
1.

At this stage, you may download and/or review the documents, if you wish.
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E.

No further action is required. The signed copy of your Rule will be securely
forwarded to Department of State staff who will indicate the Rule’s effective date
and complete the filing.
1.

F.

In the case of an Emergency Adoption, Amendment or Repeal, the signed
copy of your Rule will be securely forwarded to the Governor’s Office.
Once the Governor or Governor’s designee has applied his or her
signature, the Rule will again be securely forwarded to Department of
State staff who will complete the filing process.

You will receive an email directly from OneSpan indicating that the signing
process is completed for this Rule. This email will include a link; should you click
that link, you will receive the following message:

1.

If you click “Download Documents” a zip folder with the
documents will be downloaded.
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